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Welcome to Rapid SQL
Rapid SQL is an integrated cross-platform database development environment that provides a highly-intuitive and 
well-integrated interface. Its graphical facilities simplify SQL scripting, object management, reverse-engineering, 
database project management, version control, and schema deployment. Additionally, it provides comprehensive tools 
for tuning and editing code to ensure high-performance and quality.

Rapid SQL offers support for all major databases including IBM DB2, InterBase/Firebird, Microsoft SQL Server, 
MySQL, Oracle, and Sybase.

See the following topics:

• Rapid SQL Tutorial

• Application Basics

• Using

• Tools

• Rapid SQL Add-On Tools

Technical Requirements
Rapid SQL is a 32-bit application that runs in a Microsoft Windows environment. Before using Rapid SQL, please 
verify that your environment meets the following requirements:

• Hardware requirements

• Operating system requirements

NOTE: Users need full registry privileges during the installation and access to the keys under 
HKEY_CURRENT_USER in the registry after installation.

Hardware requirements 
Embarcadero Technologies recommends the following minimum hardware requirements:

• 500 MB of memory 

• 500 MB of disk space 

Operating system requirements
Rapid SQL supports the following operating systems:

• Windows 7

• Windows XP

• Windows Vista

For more information, see XP support and Vista and Windows 7 support. 
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XP support 
Windows XP has two user security groups: 

• Users 

• Power Users 

Microsoft intentionally does not grant members of the Users Group the authority to install applications or make global 
changes to the system. Restricted Users are members of the Users Group. Standard users belong to the Power Users 
Group. Microsoft grants members of the Power Users Group the authority to install programs.You must be a member 
of the Administrators Group in order to install and use Embarcadero Technologies applications. 

Because Restricted Users are members of the Users Group, they cannot install and run Embarcadero Technologies 
applications. 

CAUTION: You must be a member of the Administrators Group in order to install and use Embarcadero 
Technologies applications. 

To open the Group Membership tab where you can determine your group and review the Microsoft security guidelines: 

1 On the Control Panel, open User Accounts. 

2 On the Users tab, select a user and then click the Properties button. 

3 Click the Group Membership tab.

Vista and Windows 7 support
Windows Vista UAC and Windos 7 provide two user types:

• Standard user

• Administrator

Rapid SQL can be installed or uninstalled by an administrator or by a standard user using their administrator token.  
Standard users can run Rapid SQL.

CAUTION: For the purposes of running Rapid SQL, default standard user token privileges should not be 
modified.  Modifying standard user token privileges can result in licensing issues which will 
prevent Rapid SQL from operating properly.

Database Support
The table below describes the database platforms Rapid SQL supports and the server and client requirements:

Platform Server Client

IBM DB2 for OS/390 
(z/OS) 

IBM DB2 for OS/390 (z/OS) v7, v8, and v9. When going through a DB2 Connect gateway, 
DB2 Client for Windows 6.0 or later. When 
going directly to the mainframe from the 
client, DB2 Connect Personal Edition v6 or 
higher on the client machine. 

IBM DB2 for Linux, Unix, 
and Windows 

IBM DB2 Universal Database 8 and 9 IBM DB2 Client for Windows 7.2 or later.

NOTE: When using a v8 client, Rapid SQL 
only supports connecting to a v8 Database on 
Windows, Linux and Unix.
EMBARCADERO TECHNOLOGIES>RAPID SQL® XE PRO AND RAPID SQL® 7.7 USER GUIDE 14



 > 
IBM DB2 for Z/OS stored procedure requirements
When working against an IBM DB2 for z/OS data source, Rapid SQL relies on the following stored procedures, 
provided as an optional installation step in setting up the DB2 subsystem:

• DSNWZP

• DSNUTILS

• ADMIN_COMMAND_DSN

• ADMIN_COMMAND_DB2

Prior to using Rapid SQL against an IBM DB2 for z/OS data source, ensure that these components are installed on 
the server. See http://publib.boulder.ibm.com/infocenter/dzichelp/v2r2/topic/com.ibm.db2.doc.inst/stpadd.htm#stpadd 
for more information.

Licensing
Each Embarcadero client application requires one or more licenses in order to run. An Embarcadero product, such as 
DBArtisan or ER/Studio, has a baseline license which provides basic feature support for that product. In addition, 
incremental licenses may be required to support specific DBMS platforms, product add-ons, or other functions.

For more information, see the following topics:

• Licensing overview

• Licensing your application

Licensing overview
The following discussion provides a high-level discussion of key licensing topics and directs you to sources of more 
detailed information.

InterBase/Firebird InterBase 2007 and InterBase 2009 DataDirect ODBC driver for InterBase and the 
InterBase Client

Firebird 2.0 Firebird ODBC Driver

Microsoft SQL Server Microsoft SQL Server 2000, 2005, and 2008

NOTE: For SQL Server 2005 and 2008, only 
object types like users, logins, roles, config 
parameters, etc., are supported. We do NOT 
support Microsoft .NET extensions at this 
time.

Microsoft SQL Server Client Library 

MySQL MySQL 4.x. (Rapid SQL is tolerant of 5.x but 
does not support Stored Procedures, 
Triggers, Views.)

MySQL ODBC driver 3.5.1 and above

Oracle Oracle 8i, 9i, 10g, and 11g Oracle SQL*Net Client 

Sybase ASE Sybase System 12.5, Sybase 15 Sybase Open Client 

Platform Server Client
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Viewing your license type and modules
The About... dialog, available from the Help menu, displays your license type and each individual license module 
currently registered.

License types
Three kinds of licenses are available: Trial, Workstation, and Networked.

For a detailed description of licensing options, see http://www.embarcadero.com/software-licensing-solutions.

Rapid SQL license modules, DBMS-support, and feature availability
Individual license modules correspond to the DBMS platforms you are licensed to use. In addition, each DBMS license 
module corresponds to a product edition. The following table indicates feature availability for each license module 
edition:

Rapid SQL XE Pro license modules, DBMS support, and feature availability
An XE license provides access to all supported DBMS platforms. XE modules and feature availability are as follows:

Directing queries regarding licenses
Questions regarding license availability, feature availability, and client or server licensing, should be directed as 
follows:

• If you work in an organization that uses networked licensing, direct any questions to your site’s Rapid SQL 
administrator

• If you are using workstation licensing, direct licensing questions to your Embarcadero Technologies 
representative

Licensing Your Application
See the following topics for details on registering your product:

Trial licenses A license for a 14-day, full-featured trial version of the product. The trial license must 
be registered before you can use the product.

Workstation licensing A license or set of licenses is tied to a particular workstation. The product can only 
be used on that workstation. 

Networked licensing Networked licenses are administered and distributed by a central License Server 
(Embarcadero License Center or Acresso FLEXnet Publisher). There are two types 
of networked licenses: Concurrent and Networked Named User. With Concurrent 
licensing, users on different machines take turns using licenses from a shared pool. 
With Networked Named User licensing, licenses are pre-assigned to specific users 
setup on the license server's user list. Those users are guaranteed to have licenses 
available any time. 

Standard Provides baseline support including datasource management, object management, 
SQL editing and execution, and standard tools and utilities.

Professional Standard edition features plus SQL Debugger, SQL Profiler, and Code Analyst.

XE Pro Provides baseline support including datasource management, object management, 
SQL editing and execution, and standard tools and utilities, SQL Debugger, SQL 
Profiler, and Code Analyst.
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Registering a trial or workstation license during installation

Registering a workstation license after application startup

Registering by phone

Registering a networked license

Registering a trial or workstation license during installation
Shortly after initiating download of a trial version of an Embarcadero product, you should receive an email with a serial 
number you must register during installation.  Similarly, if you purchase an Embarcadero product while no trial version 
is active, you will receive serial number that must be registered during installation.

1 Start the installation. An Embarcadero License Registration dialog appears.

2 Copy the serial number from the email and paste it in the Serial Number field.

3 Enter your Embarcadero Developer Network account credentials in the Login or Email and Password fields. If 
you have not previously created an EDN account, or have forgotten your password, click I need to create ... or 
I’ve lost my password.

4 Click Register.

Your activation file should be downloaded and installed automatically. If this does not happen, click the Trouble 
Connecting? Try Web Registration link and follow the prompts. If you still have problems, see Registering by phone.

Registering a workstation license after application startup
The following instructions assume that you have received a workstation license by email and that you currently have a 
valid trial license. If you did not install a trial version or the trial period has expired, follow the instructions in 
Registering a Trial or Workstation License at Application Startup instead.

1 On the Help menu select About and then on the dialog that opens, click Manage to open a license manager 
dialog.

2 On the Serial menu, select Add Serial Number.

3 Copy the serial number from the email and paste it in the Add Serial Number dialog, then click OK.

4 Right-click on the serial number you added, and then select Register from the context menu. A registration 
dialog opens.

NOTE: The Registration Code box shows a machine-specific identifier required with other registration 
methods.

5 Ensure that the Register using Online Registration radio box is selected.

6 Provide Developer Network credentials in the Login name or Email and Password boxes. If you have not 
previously created an EDN account, or have forgotten your password, click I need to create ... or I’ve lost my 
password.

7 Click Register.

8 If prompted to restart the application, click Yes.

Your activation file should be downloaded and installed automatically. If this does not happen, click the Trouble 
Connecting? Try Web Registration link and follow the prompts. If you still have problems, see Registering by phone.
EMBARCADERO TECHNOLOGIES>RAPID SQL® XE PRO AND RAPID SQL® 7.7 USER GUIDE 17



 > 
Registering by phone
If you have problems with either of the above procedures, you can register licenses by phone. You will have to provide 
Developer Network credentials; the registration code displayed in the Embarcadero License Registration dialog that 
appears when you start an unlicensed application; the product base license serial number; and the license serial 
numbers for any additional features you have purchased.

For North America, Latin America and Asia Pacific, call (415) 834-3131 option 2 and then follow the prompts. The 
hours are Monday through Friday, 6:00 A.M. to 6:00 P.M. Pacific time.

For Europe, Africa and the Middle East, call +44 (0)1628-684 494. The hours are Monday to Friday, 9 A.M. to 5:30
P.M. U.K. time.

Shortly after phoning in, you will receive an email containing an activation file. Then do the following:

1 Save the file to the desktop or a scratch directory such as c:\temp.

1 On the Help menu select About and then on the dialog that opens, click Register. A registration dialog opens.

2 Select the I have received an activation file (*.slp or reg*.txt) radio box.

3 Click the Browse button and use the Select License Activation File dialog to locate and select the activation 
file you installed.

4 Click the Import button to import the activation file and when complete, click the Finish button.

5 If prompted to restart the application, click Yes.

Registering a networked license
If you work in an organization using Networked licensing, an administrator, department head, or someone providing a 
similar function will provide you with an activation file.

Once you receive the file, save it to the license subfolder of your product’s main installation folder (typically 
C:\Program Files\Embarcadero\<product><version>\license\), then restart the application.

No additional steps are necessary.
EMBARCADERO TECHNOLOGIES>RAPID SQL® XE PRO AND RAPID SQL® 7.7 USER GUIDE 18



Rapid SQL Tutorial
Embarcadero Rapid SQL® is an integrated development environment that enables developers to create, edit, version, 
tune, and deploy server-side objects residing on Microsoft® SQL Server, InterBase/Firebird, Oracle®, Sybase 
Adaptive Server®, IBM® LUW DB2®, and IBM® DB2® for OS/390® databases. Its unified database development 
environment provides extensive graphical facilities that simplify SQL scripting, object management, reverse 
engineering, database project management, version control, and schema deployment. With Rapid SQL, programmers 
can develop and maintain high-quality, high-performance client/server and Web-based applications in less time, and 
with greater accuracy.

This tutorial is intended to help you get started using Embarcadero Rapid SQL. After completing this tutorial, you will 
have the foundation you need to explore the many features of Rapid SQL. You will have learned how to register and 
connect cross-platform datasources; navigate the database Explorer; work with the individual object browsers, editors, 
and wizards; build and manage projects; and leverage many of the productivity-focused features offered throughout 
Rapid SQL. Rapid SQL allows you to concentrate more on what needs to be done and less on how it should be done.

This tutorial is divided into six sessions. Do them all at once, or complete them individually as you have time. 

• Session 1: Getting Started with Rapid SQL

• Session 2: Productivity Enhancers

• Session 3: Database Object Management Made Easy

• Session 4: Building a Database Project

• Session 5: Visual Query Builder and Data Editor

• Session 6: SQL Debugging and Profiling

You can use this tutorial as a road map of product highlights, and to help familiarize yourself with key product features.

Once you begin, select Help from the Toolbar to browse additional online help resources, including documentation 
that complements and builds upon the activities outlined in this tutorial.

Session 1: Getting Started with Rapid SQL

Download and Install
You can obtain the latest version of the Rapid SQL software from the Embarcadero Web site at 
http://www.embarcadero.com/products/rapid-sql.

Provide the requested information and follow the steps indicated to download and install the software. When you first 
install an evaluation copy of Rapid SQL, you can use the tool for 14 days once you register your trial license. After that 
time, a permanent license is needed. 

Proceed to Overview.

Overview
Rapid SQL allows you to view and manage datasources via the Database Explorer. The Database Explorer enables 
navigation between different datasource platforms from the same window. Additionally, the Rapid SQL environment 
enables multiple workspaces to be opened at the same time, allowing you to work while application processes run in 
the background.
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Start Rapid SQL
1 On the Start menu, navigate to Programs, Embarcadero RapidSQL 7.7.0, and select Rapid SQL 7.7.0.

The first time Rapid SQL starts, a dialog appears prompting a search for pre-existing datasources that have 
been registered in other Embarcadero applications. Selecting Yes prompts Rapid SQL to search and locate any 
datasources defined in the datasource catalog (defined on the machine identified in the Options field). For the 
purposes of this tutorial, select No.

2 Click OK to continue.

Rapid SQL provides a feature that automatically searches the DBMS configurations on the network or installation 
machine and finds datasources residing on the system that are not currently registered. The Discover Datasources 
dialog contains a list of these datasources that includes the name of the datasource server or instance, and the type of 
DBMS. Use the Discover Datasources dialog to register datasources in Rapid SQL.

Registering Cross-Platform Datasources
Datasource registration is performed via the Datasource Registration Wizard. It opens automatically via the 
Discover Datasources dialog (when you click OK), and can also be opened manually from Rapid SQL’s Main Menu. 
(Datasource>Register Datasource.)

Registering a Datasource
Rapid SQL provides the same interface for registering all supported DBMS platforms. Each datasource’s connection 
information and log on details only need to be set up once per datasource instance. This connection information can 
be saved locally, or in a common datasource catalog for use in other Embarcadero products requiring datasource 
registration.

You can configure Embarcadero products to use a datasource catalog stored in the system registry of your machine 
(locally), or use a datasource catalog located in the registry of a remote machine. This capability provides the ability to 
easily share datasource catalogs among multiple users and workstations, and creates a highly-maintainable 
development environment.

All Embarcadero database management products share the datasource catalog. You can set up your datasource 
catalog using one product (such as Rapid SQL), and the same list of datasource will be made available in other 
Embarcadero Technologies products. Any changes you make to the datasource catalog are reflected in all 
Embarcadero database management products.

To register a Microsoft SQL Server datasource

1 From the Datasource menu select Register Datasource.

2 On the first panel of the Datasource Registration Wizard, select Microsoft SQL Server as the database type 
and then click Next.

3 Use the controls on the Connection Information panel to select a Microsoft SQL Server datasource on your 
network and then click Next.

4 On the Security Parameters panel, provide valid credentials in the User ID and Password boxes and select the 
Auto-Connect? to avoid having to provide credentials each time you connect to this datasource. Click Next to 
continue.

5 Since the Datasource Properties panel references an advanced feature, click Next.

6 In the Datasource Group tree, indicate where the datasource you are currently registering will sit. Click Finish to 
complete the Wizard and when prompted, connect to the datasource. The datasource is registered with the 
instance of Rapid SQL, and it can now be manipulated via the Rapid SQL interface.

Proceed to Session 2: Productivity Enhancers.
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Session 2: Productivity Enhancers

Database Object Management Made Easy
Rapid SQL provides the Database Explorer Tree to provide an easy and intuitive way to drill down into atomic 
database objects. The Database Explorer Tree displays all registered datasources and serves as the entry-point to 
much of Rapid SQL’s advanced functionality.

Viewing Datasources and Datasource Objects in the Explorer Tree
1 On the Explorer, select By Object Type.

The Explorer displays objects organized by type.

2 Under the datasource you registered, expand the Databases node and drill down further by expanding the Pubs 
node. The datasource object types for that database are displayed.

3 Expand the Tables node to view a list of table objects contained in the SAMPLE_DATASOURCE database.

Proceed to Creating an Object Using the Object Creation Wizard.

Creating an Object Using the Object Creation Wizard
You can create database objects via Object Creation Wizards accessed from the Database Explorer. The following 
steps provide an example of how to use the Table Object Creation Wizard to create a new Oracle table.

Using the Table Object Creation Wizard
1 Right-click the Tables node and select New from the menu. The Create Table Wizard appears.

2 Enter the appropriate information on the panels of the wizard:

• On the Properties panel, select a Schema, provide a table name of SAMPLE_TABLE, and optionally modify 
other properties.

• On the Columns panel, type a column name of sample_column1, and optionally modify other column 
attributes. Experiment with the Add Column and Delete buttons.

• Proceed through the Indexes, Constraints, and Permissions panels, optionally making changes.

• On the DDL View panel, inspect the DDL generated by your choices and when ready click Execute. Your new 
table is created.

NOTE: Rapid SQL builds syntactically-correct code that is ready to run the first time it is generated. 
Manual coding is not required in any of the Object Creation Wizards.

In the case of tables, Rapid SQL automatically opens an editor on the newly created object. 

3 For now, close the object editor window.

Proceed to Working With an Existing Object Using the Object Editor.
EMBARCADERO TECHNOLOGIES>RAPID SQL® XE PRO AND RAPID SQL® 7.7 USER GUIDE 21



 > 
Working With an Existing Object Using the Object Editor
Once an object is created, it can be modified via the same Object Editor. Object Editors perform modification 
operations that would normally require painstaking and error-prone scripting, such as deleting or inserting columns in 
a table while preserving data, dependencies, and permissions. Rapid SQL analyzes the database catalog to 
determine its structure, and then automatically generates the appropriate SQL script required for the extended 
alteration.

For example, when a full table alteration is required, Rapid SQL automatically unloads and reloads the data, 
eliminating most of the tedious work a manual alteration would require.

When an object is created, Rapid SQL automatically opens an individual Object Editor for the newly-created object.

To modify an existing object
1 On the Explorer, navigate to the Tables node of the datasource defined previously.

2 Right-click the table you created in the previous exercise and select Open from the context menu. 

Rapid SQL opens the Table Object Editor and you can proceed to modify the selected object.

3 Inspect the editor and note that it has tabs not available on the wizard you used to create the table. Close the 
editor window.

Proceed to Object Documentation and Reporting.

Object Documentation and Reporting
Rapid SQL can provide HTML reports for all database objects. The reports are automatically displayed in the Rapid 
SQL application workspace, but can be saved as a new file, or referenced in the original file. All HTML reports are 
browser-ready and suitable for posting directly to the Web.

To generate an HTML report
1 On the Explorer, open any datasource and navigate to the Tables node.

2 Right-click an object and select Report from the menu. The Report dialog appears.

3 Enter the appropriate information in the fields provided:

• In the Report Home Page File Name field, type the directory path and file name of the report manually, or 
click Browse and navigate to the path and file name. This value supports network Web server paths.

• In the Report Title dialog, type the name of the report.

4 Click Execute. The HTML report is automatically generated to the path defined in the Report Home Page File 
Name field in Step 3 and displayed in the Rapid SQL application workspace.

Proceed to Working With Code, Files and Data.

Working With Code, Files and Data
Rapid SQL provides many features and powerful development tools for creating and executing SQL code and working 
with data. This section of the tutorial will provide a high-level functionality overview of the major development features 
and tools within Rapid SQL.

Setting Environment Options
The Options Editor provides an interface for you to set Rapid SQL environment parameters to meet your 
development requirements.
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To set development environment parameters
1 Select File>Options. The Options Editor dialog opens.

2 Click on the General Tab. General settings are displayed and modified by selecting them from the dropdown 
menu or via the tabbed window.

3 Adjust the development parameters as required and click OK. The environment options are automatically applied 
to all registered datasources.

Using the Favorites Tab
The Favorites Tab provides a drag-and-drop library interface of all supported DBMS syntax, SQL syntax, built-in 
functions, optimizer hints, and SQL-conditional syntax. Additionally, it provides the ability to create custom folders to 
store commonly-used code for quick and efficient access, as needed.

To open the Favorites Explorer
1 At the bottom of the Explorer pane, click Favorites. The Favorites Explorer appears.

2 Expand the Microsoft node and then expend the Schema subnode.

3 RIght-click the Procedures node and select Open. The selected code opens in the SQL Editor window and is 
ready for execution.

To add a custom folder to the Favorites Explorer
1 Open the Favorites Explorer and right-click the Favorites folder.

2 Select New Folder from the menu. A new folder is added to the bottom of the tree view.

To add an existing script to the Favorites Tab
1 Select New>SQL, create a two or three-line script in the SQL editor, and then save your script.

2 After saving the script, right-click anywhere on the workspace and select Add to Favorites. The Favorite 
Properties dialog box opens.

3 Enter the appropriate information in the fields provided. The script is added to the Favorites Explorer.

NOTE: Code from the Paste SQL, Paste SQL Syntax, and Favorites Tab are available from any SQL 
or DDL Editing window.

Proceed to Working with Scripts and Files.

Working with Scripts and Files
Rapid SQL extends the auto-generation of SQL code by allowing you to run your scripts across multiple databases at 
the same time. Additionally, Rapid SQL provides the option to execute code immediately, or schedule it to run later.

Using the Script Execution Facility
1 On the Favorites Explorer, navigate to the Microsoft SQL Server node and select the Schema subnode.

2 Right-click the Procedures node and select Script Execution Facility. The Script Execution Facility dialog 
box appears.

3 Click the Target Tab and select the datasources against which the script will run.

4 Click the Output Tab and select a type of output format. For the purposes of this example, select Graphical 
Output.
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5 If you want to send a notification message indicating that the script has executed, click the Notify Tab and enter 
the appropriate information in the fields provided.

6 Click Execute. Rapid SQL runs the script against the datasources specified on the Target Tab.

NOTE: Separate script output windows are created for each selected datasource.

Using the File Execution Facility
Similar to the Script Execution Facility, files containing SQL scripts can be added to the File Execution Facility and 
executed immediately or scheduled to run later. Other than code’s origin, all supporting functionality is the same. 

1 On the Tools toolbar, click File Execution Facility.

Rapid SQL opens the File Execution Facility dialog box.

2 To locate the file you want to execute, click Add. Use the Select Files dialog box to locate and select a file.

3 On the Target Tab, select the datasources to run the script against.

4 On the Output Tab, select the desired output option. For the purposes of this example, select Graphical Output.

NOTE: To enable the scheduling function for the script, you must select the File Output option. 

5 If you want to send notification that the script has executed, on the Notify Tab, complete the target information.

6 Click Execute. 

Rapid SQL runs the script against the target datasources.

NOTE: Separate script output windows are created for each selected datasource.

Proceed to Viewing Data.

Viewing Data
Rapid SQL provides several options for browsing data. In addition, it gives you the ability to construct even the most 
complex SQL statements with point-and-click ease.

Select * Browsing (SQL Server Example)
1 On the Database Explorer ensure that the Explorer tab is displayed and then expand the MS SQL server node. 

2 Expand any database you know has table data, expand the Tables node, right-click a table, and then click 
SELECT * FROM. 

All columns and rows from the table are displayed in the active workspace.

Retaining Datasource Explorer View Settings
1 On the Explorer dropdown, select Retain View Setting.

The next time you open the Explorer, it will open just as you left it. All connections that were present when you closed 
Rapid SQL will be reestablished. 
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Datasource Explorer Bookmarks
Rapid SQL allows you to set bookmarks for frequently visited database objects.

1 On the Datasource Explorer, right-click any node.

2 Select Add Bookmark.

You can modify the bookmark name as desired.

After Bookmarks are defined you can use them to easily navigate to commonly used datasource resources via the 
main menu Bookmarks item.     

You can use the Bookmark Manager to maintain your Bookmarks.
1 Select Bookmarks>Bookmark Manager. 

The Bookmark Manager dialog box opens where you can rename, move, and delete bookmarks.

Setting Keyboard Shortcuts and Hot Keys
1 Select Tools>Customize.

The Customize dialog box opens.

2 In the Customize dialog box, open the Keyboard Tab.

• The Keyboard Tab can be used to set Keyboard shortcut hot keys for all areas of Rapid SQL functionality.

Referencing Most Recently Used Datasources
1 From the File menu, select Recent Datasources, and then choose a datasource.

This will automatically place you on the datasource within the Explorer, ready to work with an active connection.

Proceed to Session 3: Scripting.

Session 3: Scripting
By providing several code generation and assistance options, Rapid SQL makes cross-platform development easy for 
developers of all experience levels. 

NOTE: The following examples build on the MS SQL Server SAMPLE_DATASOURCE registered earlier 
in this tutorial. These examples can be applied to any registered datasource for any of the 
supported platforms. 

Proceed to Generating Code.

Generating Code
The Code Generation Facility can be used to create complete procedures, functions or packages revolving around 
views or tables.

To open the Code Generation Facility
1 From the Tools toolbar, click Code Generation Facility.

Rapid SQL opens the Embarcadero Code Generator dialog box.
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2 In the datasource list box, select the target datasource from the drop-down list.

3 In the database list box, select pubs.

4 In the Tables/Views pane, click Tables, and then select authors.

5 In the Select 1 or More Where Clause Columns box, select state.

6 In the Select 1 or More Output Columns box, select all columns.

7 In the Generate box, choose Select (this is the code option).

8 In the Provide an Output File Name, type or browse and locate a target file where you want to save the 
generated script, and then click Open.

9 Click OK. 

The DDL to create the procedure is generated and displayed in an editable window called the DDL Editor. You 
can edit the name of the new procedure and any of the generated code at this time. 

10 Name the new procedure sample_select_authors.

11 To submit the DDL and create the procedure, click Execute or Step Execute in the toolbar above the editor.

The indicated file will be saved on the selected directory.

NOTE: No SQL statement coding is required to generate complete stored procedures and packages. If 
applicable, Rapid SQL allows all generated code to be previewed and edited to fit any 
development need. 

Right-Click Feature
Similar to the Code Generation Facility, the right-click code generation feature can be used to create complete 
procedures, functions, or packages revolving around views or tables.

1 On the Database Explorer, expand the MS SQL server node. 

2 Expand any database, and then expand the pubs node.

3 Expand the Tables node, and right-click the authors table.

4 From the pop-up list, select Generate, Procedure, and then Select.

5 In the Input Columns pane, select state. 

6 In the Output Columns pane, leave all output columns selected.

7 Click OK.

The DDL to create the procedure is generated and displayed in an editable window, called the DDL Editor. You 
can edit the name of the new procedure and any of the generated code.

To submit the DDL and create the procedure, click Execute or Step Execute. 

NOTE: No SQL statement coding is required to generate complete stored procedures and packages. If 
applicable, Rapid SQL allows all generated code to be previewed and edited to fit any 
development need.

Proceed to Code Assistance.
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Code Assistance
Rapid SQL provides extensive, easy-to-use code assistance features for all supported DBMS platforms, throughout 
the application. Assistance is provided in the form of ready-to-use code templates and blocks of syntactically correct 
code.

Paste SQL 
1 On the Database Explorer, expand the MS SQL server node. 

2 Expand any database, and then expand the pubs node.

3 To open a SQL Editor window, from the main toolbar, select File, New, and then SQL (Ctrl+N).

4 On the Edit toolbar, select Paste SQL Statement.

The Paste SQL dialog box opens.

5 In the Tables pane, select the authors table.

6 In the Columns pane, select all columns. 

7 In the Statement column, click Select as the generation option.

8 To copy the generated code to the SQL Editor workspace, click Paste Statement.

NOTE: You can use the statement as is, or modify the code as needed.

Paste SQL Syntax 
1 On the Database Explorer, expand the MS SQL server node. 

2 Expand any database, and then expand the pubs node.

3 To open a SQL Editor window, from the main toolbar, select File, New, and then SQL (Ctrl+N).

4 On the Edit toolbar, select Paste SQL. 

The SQL Syntax for SQL Server dialog box opens.

5 In the SQL Statements: pane, click a target template.

The template syntax appears in the Syntax pane.

6 To copy the code into the SQL Editor workspace, click Paste.

NOTE: You can add your own code to complete the needed operation.

Proceed to Session 4: Building a Database Project.

Session 4: Building a Database Project
Rapid SQL provides an excellent team development environment that allows you to reverse engineer live database 
objects into off-line SQL source code files that can then be easily added to a version control system (VCS). Rapid 
SQL’s seamless VCS integration offers all version control operations, such as get, check-out, check-in, history, and 
diff. 

Proceed to Creating a New Rapid SQL Project.
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Creating a New Rapid SQL Project
The example below reverse engineers the table objects from the Microsoft SQL Server pubs database into a Rapid 
SQL project, and then adds the project to version control using Microsoft Visual Source Safe.

To create a new project:
1 On the main toolbar, select File, New, and then Project.

The New Project dialog box opens.

2 In the Name text box, type sample_project.

3 In the Location text box, type or browse and locate a directory that contains a VSS database.

4 Optionally, enter a description.

5 Under Initialize New Project, select From Database.

6 Click OK.

The New Project Reverse Engineering Wizard opens.

7 In the Select a Datasource box, select the datasource you created.

8 Click Next.

The next panel of the wizards opens.

9 In the Select Database to reverse-engineer window, select pubs.

10 Click Next. 

The next panel of the wizard opens.

11 From the Owners list box, select dbo.

12 In the Object Type box, right-click to unselect all options, and then select Tables.

13 In the Extract Scope box, select Selected Objects Only.

14 Click Next.

The next panel of the wizard opens.

15 In the Object Type box, select Tables from the drop-down list, and then select the authors, discounts, and 
employee tables.

16 In the Options for Tables box, right-click to Unselect All.

17 Click Next.

The next panel of the wizard opens.

18 18.For Object Ownership, select Retain.

19 Click Next.

The Preview panel of the wizard opens so you can review the project you are creating.

20 Click Execute.

You have now successfully created a working database project. At this point, the project is available to be added to 
Version Control. This can be done by clicking Yes when prompted and following the dialog, or by right- clicking the 
project on the Project Explorer. Select Yes for the purpose of this example.

Proceed to Adding a Project to Version Control (Sample - Microsoft Visual Source Safe).
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Adding a Project to Version Control (Sample - Microsoft Visual Source 
Safe)
When a project is created Rapid SQL will automatically prompt you to add the project files to the selected VCS (see 
Setting Environment Options below).The dialog you see is displayed below: 

1 In the Visual SourceSafe Login dialog box, enter the Username and Password.

2 Type or browse and locate the target database, and then click Open.

The Add to SourceSafe Project dialog box opens.

3 To name your project, in the Project text box type “sample_project”.

4 Click OK.

You receive the message below to indicate that your project was successfully placed in the VSS.

Proceed to Section 5: Visual Query Builder and Data Editor.

Section 5: Visual Query Builder and Data Editor
Rapid SQL gives you the ability to construct complex SQL statements with point-and-click ease using the Visual Query 
Builder.

Visual Query Builder
1 On the Database Explorer, expand the MS SQL Server node, and then select pubs.

2 Expand the pubs node, and then select Tables.

3  Right-click the authors table and select Build Query.

The authors table is automatically added to the Query Builder workspace. 

4 Right-click the titleauthor table and select Add. 

NOTE: Note that the tables are automatically identified as being joined by any columns with the same 
name and datatype. 

5 To expose the Visual Query Building clauses and options, open the DML Tab. 

6 Right-click on any clause to initiate a change to the clause.

7 Click the Execute button on the toolbar above the Build Query workspace.

The query executes and the lower window displays the results. The generated SQL is also available in the lower 
window.

NOTE: Any visual query builder session can easily be saved to a file for later use.

Live Data Editor
1 On the Database Explorer, expand the MS SQL Server node, and then select pubs.

2 Expand the pubs node, and then select Tables.

3 Right-click the authors table and select Edit Data.

Rapid SQL opens the Data Editor Filter dialog box.
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4 In the Columns box, select Add All. Optionally, you can add a WHERE clause that will filter for only the desired 
data. 

5 Click OK. The editing window opens.

NOTE: Rapid SQL builds the SQL to retrieve the data to be edited in the lower window.

• The editing window has LIVE and BATCH modes. LIVE mode commits your changes each time you move to a 
new row. BATCH mode will allow you to move within the window and commit your changes when ready.

• Changes made in BATCH mode can be cancelled by selecting Reload Data.

Proceed to Section 6: SQL Debugging and Profiling.

Section 6: SQL Debugging and Profiling

SQL Debugging
The SQL Debugger is another database productivity tool that lets you debug SQL Server, Oracle, Sybase or IBM DB2 
LUW for Open Systems stored procedures as well as Oracle functions. SQL Debugger simplifies the task of finding 
coding errors.

1 On the Database Explorer, expand the MS SQL Server node, and then select pubs.

2 Expand the pubs node, and then select Procedures.

3 Right-click the target Procedure and select Debug.

• If the procedure/function contains input variables, the Procedure Execution window prompts for entry of these 
values.

4 Enter the value(s) for the input variable(s) and press Continue.

NOTE: Pressing the Debug button or selecting Debug from the Command menu invokes The SQL 
Debugger.

TIP: Rapid SQL allows the user to save the input variable values to a file for later use. This is very 
helpful for procedures/functions with many input variables that need to be run repeatedly.

The application opens the SQL Debugger Interface.

SQL Profiling- Oracle Only
The SQL Profiler within Rapid SQL provides the ability to capture the metrics of various PL/SQL programmable 
objects as they are executed in the database. It quickly identifies performance bottlenecks by first calculating the 
overall runtimes of objects like Oracle packages, and then computing the amount of time each line of PL/SQL code 
spends executing. Information is presented in an easily viewed, drill-down format.

To start a profiling session:
1 From the Tools menu select SQL Profiler, Start.

OR

From the SQL Profiler toolbar, click the Start Profiling button Execute.

The Profiler Start dialog box opens.

2 Enter a name for the profiling session, or select an existing name from the drop-down list.
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3 Click OK.

The Profiler session is now active.

4 Select the programmable object you want to capture metrics for, and click Execute.

5 When finished, from the SQL Profiler toolbar, click Stop.

The SQL Profiler Stop dialog box opens.

• Stop & Analyze – Stops the profiling session and presents the detail profiling information.

• Stop – Stops the profiling and leave the user on the current screen.

• Cancel – Cancels the stop command.

• Help – Displays SQL Profiler Help

6 Click Stop.

7 Expand the PL/SQL Code Profiling section.

8 Right-click the profile session, and then select Run Summary.

The Run Summary appears.

9 Right-click a session and select Run Detail. 

The Run Detail screen appears and allows you to view the metrics for the run in both a graphical and text format.

10 To drill down further into the data, right-click a unit, select Unit Detail.

NOTE: You can scroll through the Source window to view the execution times for each statement.

To compare two cases:
1 From the Run Summary screen, select the two cases you wish to compare (SHIFT+CLICK to select the second 

case), and then right-click and select Compare.

Additional Evaluation Resources
Embarcadero Technologies provides a variety of resources to help support your evaluation and selection of a 
development tool for your organization. 

Web site
Visit our Web site for current product and company information, educational materials and supporting information. Visit 
www.embarcadero.com

Electronic Documentation
Detailed reference documentation is available on the Rapid SQL Evaluation CD or online at 
www.embarcadero.com/support 

Online FAQ
The Rapid SQL online FAQ provides answers to commonly asked questions regarding licensing, installation and other 
helpful topics.
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E-mail Support
You can contact Rapid SQL support engineers, consultants and engineers directly by sending inquiries to 
support@embarcadero.com

Telephone Support
We encourage you to call us anytime you would like help or have questions during your evaluation. Please call 
415.834.3131 ext. 2, Monday to Friday, 6:00am - 6:00pm PST, Saturday and Sunday, 8:00am - 5:00 PST.
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Application Basics
Application Basics is designed to situate you within the application and to provide information about what Rapid SQL 
offers in the way of design, navigation, and application features. The information presented here is high-level and 
conceptual. For information on how to use Rapid SQL, see Using.

Application Basics is divided into two sections, the table below describes each section:

Product Design
The Rapid SQL window opens with the Database Explorer on the left, the Workspace on the right, and all toolbars 
docked at the top of the application. The Output Window is not automatically displayed. Rapid SQL also offers you a 
number of desktops, or workspaces, that you can toggle among while you work.

Database Explorer 
Rapid SQL organizes the wealth of information pertaining to your servers through its Database Explorer. The 
Database Explorer provides a fast and efficient way to access your database objects and scripts. The Database 
Explorer is a separate window containing a tree object that you can select and expand. The tree object organizes and 
nests subjects as branches. By expanding or collapsing the tree, you can efficiently browse multiple datasources. The 
Database Explorer window is dockable so that you can maneuver through the application efficiently.

The Database Explorer includes three tabs:

• Explorer

• Favorites

• Project

• VC Files

Explorer Tab 
The Explorer Tab provides a visual method for browsing, accessing and manipulating your database objects. The 
Explorer Tab lets you:

• Connect, disconnect, and browse the objects in the supported datasources on your network.

• Drag objects to the Rapid SQL workspace.

• Create new objects.

NOTE: You can assign datasources to defined categories such as production or development. This lets 
you color-code and label Datasource Explorer user interface elements associated with the 
datasource. For details, see Categorizing datasources using color-coding and labelling.

Section Description

Product Design This section describes the Rapid SQL user interface.

Specifying Rapid SQL 
application and feature 
options

This section describes how to customize Rapid SQL’s 
configuration to suit your specific needs. 
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Datasource Node 
When you click the datasource node of the Explorer Tab tree, Rapid SQL lists all the databases available for that 
datasource. When you click a database node, you can view all the database object types available for that datasource. 
When expand an object type node, Rapid SQL displays available objects. You can collapse any portion of a 
datasource to concentrate on a particular portion of your database.

For more information, see:

Organizing the Explorer

Creating New Objects from the Explorer 

Extracting DDL from the Explorer 

Displaying Dependencies from the Explorer Tab

Organizing the Explorer 
Rapid SQL contains functionality that lets you configure how objects are organized in the Explorer Tab. The table 
below explains the available options:

TIP: You can also set these options on the Explorer tab of the Options Editor. For details, see Explorer 
options.

Organizing the Explorer by Object Owner
1 On the Explorer Tab, click the Explorer list above the list of datasource groups.

2 Click Organize by Owner.

Rapid SQL dynamically reorganizes the display of the Explorer Tab, sorting database objects by object owner.

Functionality Description

Organize by Object Type Select to display objects by object type for all users in the same 
list. This display mode cuts performance in databases that contain 
many objects.

Organize by Owner Select to display objects by owner. Most efficient if you are working 
with databases containing a high number of objects.

Show Only My Objects Select to display the objects you own in the Explorer Tab. Available 
if you are organizing the Explorer Tab by object type.

Show System Objects Select to display system objects.

Full Refresh Select to refresh.

Expand All Groups Select to expand all groups.

Collapse Select to collapse all datasources or collapse all groups.

Retain Group View Settings Select to retain the current state of the Explorer Tab so that the it 
opens the same way the next time you start Rapid SQL.
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Organizing the Explorer by Object Type
To organize the Explorer by Object Type, do the following:

1 On the Explorer Tab, click the Explorer list above the list of datasource groups.

2 Click Organize by Object Type.

Rapid SQL dynamically reorganizes the display of the Explorer Tab, sorting database objects by type.

Showing or Hiding System Objects
To show or hide system objects, do the following:

1 On the Explorer Tab, click the Explorer list above the list of datasource groups.

2 Click Show System Objects to show all system objects.

3 Click the Show System Objects again to hide all system objects.

Creating New Objects from the Explorer 
Rapid SQL lets you create new database objects from the Explorer Tab. When you create an object from the Explorer 
Tab, Rapid SQL does the following:

• Automatically brings up the Object Attachment Facility which associates the new object with an object type.

• Opens a DDL Editor containing a shell script based on the object type you select.

• Automatically ties that object to the current database.

Creating a New Object from the Explorer
To create a new object from the Explorer, do the following:

1 In the Explorer Tab, right-click the object type node for the object to create and then click New to open the 
wizard associated with that object.

The Object Type Information dialog box displays. The object type and owner are automatically assigned based 
on the object type you selected in the previous step.

2 Enter the name of the object.

3 Click OK.

Rapid SQL opens an editor containing a template for the object type.

Extracting DDL from the Explorer
Rapid SQL's Explorer Tab provides a quick, convenient method for extracting object DDL. Rapid SQL lets you extract 
the DDL for multiple or individual database objects. SQL scripts are the text of statements that are used to create 
database objects. Rapid SQL also lets you run SQL scripts against other databases to recreate the database objects. 
You can also extract scripts to create a record of how an object was created. Rapid SQL lets you extract the CREATE 
statements for any object into a DDL Editor. If you are extracting the DDL of an Oracle procedural logic object, an SQL 
Editor automatically opens instead, saving you the trouble of inserting PL/SQL tags.

Rapid SQL offers two ways to extract DDL from the Explorer Tab:
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Using the Shortcut Menu 
1 Select one or more objects in the Explorer Tab. To select contiguous objects, hold SHIFT and select multiple 

objects. To select noncontiguous objects, hold ALT and select specific objects.

2 Right-click to display the shortcut menu and then click Extract.

Dragging Objects
1 Select one or more objects in the Explorer Tab. To select contiguous objects, hold SHIFT and select multiple 

objects. To select non-contiguous objects, hold ALT and select specific objects.

2 Drag the script(s) to the desired position in the Rapid SQL workspace.

Displaying Dependencies from the Explorer Tab   
Rapid SQL lets you open a result set window, directly from the Explorer Tab, to display dependencies for an object.

 Displaying Dependencies from the Explorer Tab
1 On the Explorer Tab, double-click the object node.

Rapid SQL displays the list of objects.

2 Right-click the target object and then click Dependencies.

Rapid SQL opens the Dependencies window which lists all dependent objects.

NOTE: Rapid SQL does not retrieve dependencies if objects are created out of order.

Filtering in the Explorer
For ease of navigation, Rapid SQL lets you filter the Explorer tree to display only selected nodes and objects. Rapid 
SQL offers the following filtering options:

• Real-time modification of the tree to show only nodes with names matching a typed character string. For details, 
see Simple, on-the-fly, character-based tree filtering.

• Permanent object filters, enabled and disabled for individual data sources, that restrict display based on object 
name and owning schema (and optionally, object type). For details, see Object name/schema filtering.

• The ability to restrict object types displayed for each DBMS platform. For details, see Node, or object type, 
filtering.

Two default filters applying to owned and system objects are available. For details, see Using the default filters. 
Default and custom filters are available in the Explorer tree Filters node for each data source. For details, see Filters 
Node.

Simple, on-the-fly, character-based tree filtering
The Filter box at the top of the Explorer provides a quick, ad hoc way to restrict the nodes displayed.

To restrict the Explorer tree display to only user-defined nodes whose name contains a particular character 
string:

• Type one or more characters in the Filter box.
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The display is updated to show only nodes whose name contains the typed character string and their parent nodes.

NOTE: The Clear button in the Filter box (X) deletes the contents of the Filter box and restores the 
unfiltered tree display.

Object name/schema filtering
Object filters let you restrict Explorer tree display for a data source by name, owning schema, or name/schema 
combinations. These filters are defined at the DBMS platform level and enabled or disabled on a data source by data 
source level. Multiple object filters can be created for a DBMS platform, letting you enable combinations of filters for a 
single data source, ad hoc enabling and disabling of individual filters depending on your requirements, and so on.

Each filter consists of one or more ANDed conditions based on name or schema. For example you could create a 
two-condition filter that restricts the Explorer tree for a data source to display only objects belonging to the Schema 
QA and whose name starts with the string Test. 

Each filter condition is a simple expression that tests object names for equality (Equals, Not Equals), inclusion in a 
specified list (In, Not In), or using pattern matching (Like, Not Like). Optionally, an object filter can also be used to 
restrict display of specified object types on a data source.

To create an object filter that can be enabled for all data sources for a DBMS platform:
1 Right-click in the left pane of the Datasource Explorer tree and select Filter from the context menu. The Filters 

dialog opens.

2 In the View area, select By Filter.

NOTE: The current instructions create a filter at the DBMS level. To create a filter for a single data source, 
select the By Datasource view, select a specific data source, and then proceed to step 4.
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3 Expand the icon corresponding to the DBMS for which you want to create a filter and ensure that the icon is 
selected.

4 Click New and type a name for the new filter.

5 On the Predicates tab, create one or more name-based or schema-based conditions, all of which must be 
satisfied when this filter is enabled. Objects that do not satisfy the conditions will be filtered from view. Use the 
following guidelines in constructing conditions:

• The Like and Not Like operators take pattern-matching Values. Use any pattern matching characters and 
conventions supported by the DBMS for which you are defining the filter.

• The In and Not In operators take a comma-delimited list such as CO,CA,CU, as a Value.

• Click the associated New button to add new predicates.

6 Optionally, on the Database Elements tab, select the check boxes for all object types to which this filter is to be 
applied. The filter does not affect the display of any deselected object types. 

7 Click OK.

By default, when you create an object filter for a DBMS platform, it is enabled for each registered data source of that 
DBMS type.

To disable or enable an object filter for a data source:
1 Right-click in the left pane of the Explorer tree and select Filter from the context menu. The Filters dialog opens.

2 In the View area, select By Datasource.

3 Expand the icon corresponding to the target DBMS and then expand the icon corresponding to the specific data 
source for which you want to for enable or disable a filter.

4 Enable an object filter by selecting the associated check box or disable the object filter by deselecting the check 
box.

5 Click OK.

NOTE: You can also enable and disable filters using controls found under the Filters node for each data 
source in the Explorer tree.

You can also use the Filters dialog to select and edit an object filter, rename or create a clone of an existing object 
filter, and delete filters.

Node, or object type, filtering
Node filtering lets you hide specified Datasource Explorer tree nodes for a DBMS platform. For example, if you do not 
typically work with credential-related objects such as users or logins, you may wish to filter those out of the 
Datasource explorer tree.

To change the hidden/displayed status of object types for a DBMS platform:
1 Right-click in empty space in the left pane of the Explorer tree and select Filter from the context menu. The 

Filters dialog opens.

2 Click the Node Filters tab.

3 Expand the icon corresponding to the DBMS for which you want to create a node filter, and continue to expand 
nodes until all nodes for which you want to change the hidden/displayed status, are visible.

4 Ensure that all nodes corresponding to objects types that are to be displayed, are selected. Similarly, ensure that 
all nodes corresponding to objects types that are to be hidden, are deselected.
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5 Click OK.

Hidden/displayed status is retained for the DBMS until you explicitly open the Filters dialog and change the current 
settings.

Using the default filters
The Filters node for each registered data source includes two default Explorer tree filters, Ignore System Objects 
and Show Only My Objects. These filters can be enabled and disabled for each data source but cannot be edited or 
deleted.

Filters Node
The Filters node contains default Explorer tree filters and any custom filters you crete for that data source or create 
across that DBMS type. Controls let you enable or disable the default and custom filters. Options for creating and 
maintaining cusom filters are provided. For details, see Filtering in the Explorer.

Favorites Tab
Rapid SQL provides the Favorites Tab for designating and accessing favorite scripts. On the Favorite Scripts Tab you 
can do the following with frequently used SQL scripts:

• View

• Navigate

• Save

• Recall

• Execute

TIP: Sample Favorite Scripts are installed for Microsoft SQL Server, Oracle, and Sybase Adaptive 
Server.

For more information, see Favorite Properties Dialog Box.

Favorite Properties Dialog Box
The table below describes the options and functionality on the Favorite Properties dialog box:

Option Description

Description Lets you enter a description.

File Name Lets you type or browse and locate a file.

Hot Key Lets you enter a Hot Key.

Hot Keys must begin with CTRL or be stand-alone function keys. 
Rapid SQL automatically places the CTRL command in front of 
any character. 

File Type Lets you select a file type.
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Subsystem Node
NOTE: The Subsystem node is available for IBM DB2 LUW for OS/390 and z/OS only.

The Subsystem node displays detailed information about the DB2 subsystem. Subsystem objects include:

• Connections

• DDF

• Parameters

Connections
Connections displays the current connections to the subsystem.

NOTE: The information is read-only.

For more information, see Subsystem Node.

DDF
DDF (distributed data facility) displays the information regarding the status and configuration of the DDF, a set of DB2 
LUW for OS/390 components through which DB2 LUW for OS/390 communicates with another RDBMS.

NOTE: The information is read-only.

For more information, see Subsystem Node.

Parameters
Parameters displays the DB2 subsystem parameters.

NOTE: The information is read-only.

For more information, see Subsystem Node.

Project Tab
The Project Tab provides a visual method for browsing, accessing, and manipulating your projects. The Project Tab 
lets you:

• Open, close, modify, and browse projects.

• Drag project items to the Rapid SQL workspace.

• Create new projects.

NOTE: The Project Tab is available after you create or open a project.

For more information on working with projects, see Project Management.
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VC Files Tab
The VC Files Tab displays open version control files. This tab displays files listed in the *.xml file for the version control 
files. The tab displays a checkbox icon for files that are checked-out.

For more information, see Version Control.

Rapid SQL Windows
The Rapid SQL interface includes several windows to help you develop your program. The windows include:

Topics
• Describe Window

• Output Window

• Browsers

• Workspaces

• Preview Dialog Boxes

Describe Window    
Rapid SQL offers a floating Describe window for procedures, tables, views, and functions (Oracle and IBM DB2 LUW 
for Open Systems only). In the Describe window, you can view columnar information (for tables and views) or input 
parameter information (for procedures and functions).

Opening the Describe Window
Rapid SQL offers three ways to open the Describe window:

1 In an editor, right-click an object and then click Describe from Cursor.

2 On the Explorer Tab, select an object and then click Describe.

3 On the Explorer Tab or in an editor, select an object and then press CTRL+D.

Using the Describe Window
In the Describe window:

1 Click the Name list and then click a name to view a list of types of objects in the database.

2 Click the Owner list and then click an owner to view a list of all owners of objects in the database.

3 Click the Type list and then click a type to view columnar information (for tables and views) or input parameter 
information (for functions and procedures).

Output Window
Rapid SQL incorporates a separate window to capture all messages returned by the server and to log entries about 
the progress of operations started by the application.

For more information, see Configuring the Output Window
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Configuring the Output Window
Rapid SQL lets you display, hide, or dock the Output Window anywhere in the application.

Displaying the Output Window 
1 On the View menu, click Output.

OR

On the Main toolbar, click Output.

Rapid SQL displays the Output Window.

Hiding the Output Window
1 On the View menu, click Output.

OR

On the Main toolbar, click Output.

OR

Right-click the Output Window and then click Hide.

Rapid SQL hides the Output Window.

Docking the Output Window
Right-click the Output Window and then click Docking View.

Rapid SQL docks the Output Window to the bottom of the application frame.

Undocking the Output Window
Right-click the Output Window and then click Docking View.

Rapid SQL displays the Output Window as a floating window in the application.

Messages in the Output Window
The Output Window lets you save, print, copy, and clear server messages.

Saving Server Messages
1 Right-click the Output Window and then click Save.

Rapid SQL opens the Save As dialog box.

2 Enter the location and name of the file in the File Name box.

NOTE: Rapid SQL defaults the file extension to .msg.

3 To save the file, click OK.
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Printing Server Messages
1 Right-click the Output Window and then click Print.

Rapid SQL opens the Print dialog box.

NOTE: Rapid SQL prompts you with information on the size of the print job before opening the Print 
dialog box.

2 Configure your print job.

3 Click OK to print the file.

Copying Server Messages 
1 Right-click the target Server Messages and then click Copy.

Rapid SQL copies the selected text to the Microsoft Windows Clipboard.

2 Paste the contents of the clipboard into target applications.

Clearing Server Messages
1 Right-click the Output Window and then click Clear.

Rapid SQL clears your Server Messages.

Browsers 
Browsers are a flexible environment where you can examine, extract, and execute database objects and their 
dependencies. Browsers provide the means to view objects types across multiple database platforms and 
connections. You can simultaneously view and work with objects from InterBase/Firebird, Oracle, Microsoft SQL 
Server, Sybase Adaptive Server, and IBM DB2 LUW for Open Systems.

The benefit of using Browsers is the ability to see detailed information about specific object types. You can also print, 
search, copy, and sort the contents of a Browser window.

Topics

• Browser Toolbar

• Opening Browsers

• Browser Object Types

• Extracting DDL from Browsers

• Displaying Dependencies from Browsers

• Refreshing Browsers

Browser Toolbar 
You can place the floating Browser toolbar anywhere on the Rapid SQL workspace.

For more information, see Browsers.
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Opening Browsers 
Browsers let you view all types of database objects, including the SQL procedures used to build them. Browsers let 
you:

• Copy database objects

• Modify database objects

• Test database objects

The ability to browse dependencies is especially useful, particularly when modifying SQL code in procedures and 
triggers. For example, in a situation where a trigger enforces a rule that does not let you update a particular box, you 
can use the Browser to do the following:

• Browse the triggers to find the offending trigger.

• Extract the DDL for that trigger into one window.

• In another window, drop the offending trigger, make your update to the box, then execute the corrected trigger 
DDL to replace the trigger in the database.

Opening a Browser Window
Rapid SQL offers two ways to open a Browser:

1 On the Browse menu, click the target object type.

OR

In the workspace, right-click, click Browser, then click the target object.

Rapid SQL opens a Browser.

For more information, see Browsers.

Browser Object Types 
Rapid SQL's Browsers read the appropriate object types for specific databases. A select statement is issued against 
the appropriate systems table based on the requested object to bring back a listing of the objects in the database. The 
table below contains a list of the Browsers available for each database platform:

Object Type DB2 LUW DB2 z/OS InterBase/Firebird SQL Server Oracle Sybase

Aliases

Blob Filters

Check 
Constraints

Clusters

Databases

Database 
Links
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Defaults

Directories

Domains

Encrypted 
Keys

Event 
Monitors

Exceptions

Extended 
Procedures

External 
Functions

Foreign Keys

Functions

Generators

Groups

Indexes

Libraries

Packages

Plans

PL/SQL Code 
Profiling

Primary Keys

Object Type DB2 LUW DB2 z/OS InterBase/Firebird SQL Server Oracle Sybase
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Procedures

Profiles

Roles

Rules

Rollback 
Segments

Segments

Sequences

Shadows

Snapshots

Snapshot 
Logs

Materialized 
Views

Materialized 
View Logs

Synonyms

Tables

Tablespaces

Triggers

Types

Type Bodies

Object Type DB2 LUW DB2 z/OS InterBase/Firebird SQL Server Oracle Sybase
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Working with Browsers
Browsers offer a versatile method of browsing and managing the contents of your databases. To help you maintain 
and organize your databases, you can:

• Print the contents of a Browser

• Search the contents of a Browser

• Copy the contents of a Browser

• Sort the contents of a Browser

Printing Browsers 
1 Open a Browser for the desired object type.

2 On the File menu, click Print to open the Print dialog box.

3 In the Name box, click the list, which contains a list of local and network printers that you can access (if you do 
not see any listed, then your computer is not configured for any printers).

4 Click the target printer.

5 In the Print Range box, click the appropriate option button to indicate print range.

6 In the Number of copies text box of the Copies box, click the Up or Down arrow or enter the number of copies.

7 Click OK.

Rapid SQL prints the selection.

Searching Browsers
1 Open a Browser for the desired object type.

2 On the Edit menu, click Find.

Rapid SQL opens the Find box.

3 In the Find What text box, enter the search string. 

4 To make the search case sensitive, select the Match Case check box. 

Unique Keys

User 
Datatypes

User 
Messages

Users

Views

Object Type DB2 LUW DB2 z/OS InterBase/Firebird SQL Server Oracle Sybase
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5 To specify the direction to search, in the Direction box, click the Up or Down option button.

6 Click Find Next.

Rapid SQL finds the next occurrence of your search string.

Copying Browsers
1 Open a Browser for the desired object type.

2 Select the objects to copy.

3 On the Edit menu, click Copy.

4 Place the pointer at the position where you want to paste the objects, and then on the Edit menu, click Paste.

Sorting Browsers 
1 Open or Create a Browser for the desired object type.

2 Double-click the column header for the column of data to sort and Rapid SQL lists the contents of the column in 
ascending order.

3 Double-click the column header again and Rapid SQL lists the contents of the column in descending order.

For more information, see Browsers.

Extracting DDL from Browsers 
For each database type, Rapid SQL provides an appropriate Browser. The Browsers are mutually exclusive object 
windows, showing only objects of a given type. If you connect to multiple datasources, you have access to a number 
of objects that are not available based on the database platform. Rapid SQL includes intelligence to determine the 
valid object types in the underlying datasource.

Using the Main Menu
1 On the Browse menu, click the target object type.

Rapid SQL opens the appropriate Browser:

2 In the Browser, double-click the target object type to extract the object type DDL into a DDL Editor.

Using the Browser Toolbar 
1 On the Browser toolbar, click Tables.

Rapid SQL opens the Table Browser:

2 Click the scroll bar arrow to locate the target table.

3 Double-click the target table.

Rapid SQL extracts the schema DDL into a DDL Editor. 

Using the Shortcut Menu 
1 Right-click an open area of the workspace, click Browsers, and then click the target object type.

2 In the Browser, double-click the target object type.

Rapid SQL extracts the schema DDL into a DDL Editor.

For more information, see Browsers.
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Displaying Dependencies from Browsers
You can display object dependencies for an object from its corresponding object Browser. Rapid SQL displays the 
dependencies in a separate result set window.

Displaying Dependencies
Rapid SQL offers three ways to display dependencies from Browsers:

1 Open a Browser for an object type.

2 In the Browser, click the target object.

3 On the Object menu, click Dependencies.

OR

On the Browser toolbar, click Dependencies.

OR

Right-click the target object and then click Dependencies.

Rapid SQL displays dependencies in a separate window.

For more information, see Browsers.

Refreshing Browsers
Rapid SQL lets you refresh and display the results of a Browser operation.

Refreshing the Browser
1 On the Object menu, click Refresh.

OR

On the Browser toolbar, click Refresh.

OR

Right-click the Browser workspace and then click Refresh.

Rapid SQL refreshes the results of the browser operation.

For more information, see Browsers.

Workspaces
Workspaces are a convenient way to maximize your desktop. You can use workspaces to multiply the amount of 
scripting, script execution, and development resources you have available at any one time. Rapid SQL lets you open 
and use several workspaces at one time. Using more than one workspace lets you:

• Execute long running scripts in one workspace while working in other workspaces.

• Develop strategies for working on scripts and result sets in one workspace while other scripts reside in one or 
more of the other workspaces.
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Toggling Between Workspaces
Rapid SQL offers two ways to toggle between workspaces:

1 On the Main toolbar, click Workspace.

OR

Right-click the current workspace and then click the target workspace.

Rapid SQL brings the target workspace forward.

For more information, see:

Managing Workspaces

Managing Workspaces
Rapid SQL provides you with three default workspaces. You manage the workspaces in the Workspace dialog box. 
Using the Workspace dialog box you can:

• Differentiate between workspaces by changing the background color or wallpaper.

• Toggle among workspaces.

• Create, delete, rename, and specify the order of workspaces.

Managing Workspaces
The Workspace dialog box lets you manage all open windows in your workspace.

1 On the Windows menu, click Windows.

Rapid SQL displays the Workspace dialog box. Any open windows in the current workspace display in the list.

The table below describes the options and functionality on the Workspace dialog box:

Set Sort Columns Dialog Box
The Set Sort Columns dialog box lets you sort multiple columns, and sort column identification, in the Right Pane of 
the application.

For more information, see Completing the Set Columns Dialog Box.

Option Description

Activate Sets the focus onto the window you have selected in the list and 
closes the Workspace dialog box.

OK Closes the Workspace dialog box and accepts any changes you 
have made to the windows in the current workspace.

Save Saves the contents of the window you have selected in the list. You 
are prompted to provide a name and location for the file you are 
saving if you have not done so already.

Close Window Closes the window you have selected from the list. If you have not 
saved the contents of the window, you are prompted with a save 
file alert.

Help Initiates and displays this Help topic in the Rapid SQL Help.
EMBARCADERO TECHNOLOGIES>RAPID SQL® XE PRO AND RAPID SQL® 7.7 USER GUIDE 50



 > 
Completing the Set Columns Dialog Box
To complete the Set Columns dialog box, do the following:

1 In the right pane of the application, right-click a column heading and select Sort Multiple Columns.

Rapid SQL opens the Set Sort Columns dialog box.

2 In Column Name select the column(s) to use to sort the information in the right pane of the application.

3 Click the right arrow to move the column(s) to the Column Name box.

4 Click the up and down arrows to change the order of the sort columns.

For more information, see Set Sort Column Dialog Box.

Preview Dialog Boxes
Before executing any code, Rapid SQL offers Preview dialog boxes to let you confirm actions before execution. In the 
Preview dialog boxes, you can:

• Preview the code to execute.

• View the SQL of the code on your database.

• Create a report detailing the affect of executing code on your database.

• Schedule execution of the code.

• Save the code to execute.

• Open your e-mail program with the code to execute as an attachment.

• Print the code to execute.

Topics: 

• Preview

• Impact Analysis

• Report

Menus
Rapid SQL offers two context-sensitive menus to let you access all the application’s features. The Main Menu is 
always on the top of the application window. The shortcut menu is accessible from almost anywhere in the application. 
Right-click to view the available shortcut menu. Rapid SQL lets you customize the Tools menu to help you tailor the 
application to your needs.

Topics
• Main Menu

• Shortcut menus

• Customizing general user interface appearance
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Main Menu
Rapid SQL's features can all be accessed from the Main Menu by clicking the menu name and selecting from the 
submenu. The menus are context sensitive and change based on the tasks you want to perform. The table below 
describes the Rapid SQL menus:

For more information, see Menus.

Explorer Bookmarks
The Bookmarks menu lets you access and manage explorer bookmarks. Explorer bookmarks let you quickly access 
nodes in the Database Explorer.

Creating Explorer Bookmarks
1 On the Database Explorer, right-click the target node, and then select Add Bookmark.

Rapid SQL opens the Add Friendly Bookmark Name dialog box.

2 Type the explorer bookmark name.

3 Click OK.

Rapid SQL displays the explorer bookmark under the Bookmarks menu. Explorer bookmarks are organized by 
platform.

Menu Item Description

File Create, open, close, print, send, and save script files and result sets. 
Set application options and defaults. 

Datasource Create, modify, select, connect to, and disconnect from datasources. 
Access the database search facility.

Project Available only when a project is open. Configure project 
management, build projects, and use version control functions.

Browse Browse any object type a datasource connection.

Logfile Activate/deactivate, open, set options, and flush the Rapid SQL 
application log.

View Arrange the Rapid SQL environment. Display or hide the Database 
Explorer, toolbars, Output Window, Describe window, activate 
full-screen mode.

Tools Choose any of Rapid SQL's tools, such as Database Search and the 
Visual Diff Utility. Customize and add tools of your own.

Bookmarks Access and manage bookmarks.

Help Access HTML Help.

Query Available only when an Editor is open. Execute and set options for 
your SQL scripts.

Object Available only when a browser is open. Execute, view dependencies, 
extract, and refresh objects in a database.

Edit Available only when an Editor is open. Edit and manipulate the text in 
your scripts.

Format Available only when a Result Window is active. Format the contents 
of result sets.

Window Cascade and tile open windows. Toggle among open windows.
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Editing Explorer Bookmarks
1 On the Main Menu, select Bookmarks.

2 Select Bookmark Manager.

Rapid SQL opens Bookmark Manager.

3 To rename the explorer bookmark, select the target explorer bookmark, and then click Rename.

Rapid SQL opens the Edit Bookmark Name dialog box.

4 Type the new explorer bookmark name.

5 Click OK.

6 To delete an explorer bookmark, select the target explorer bookmark, and then click Delete.

TIP: To add explorer bookmarks without using the Add Friendly Bookmark Name dialog box, select Do 
not show ‘Add Friendly Bookmark Name’ dialog option.

Shortcut Menus 
Rapid SQL incorporates context-sensitive menus to give you another way to access object functionality. These menus 
mirror the functionality that you can access from application toolbars or the main menu.

Opening Shortcut Menus
1 Right-click anywhere on the Rapid SQL desktop to open the appropriate shortcut menu.

For more information, see Menus.

Toolbars
Rapid SQL toolbars change to reflect the element of the application you are using. The toolbars contain icons that are 
the fastest way to access commonly used features of Rapid SQL. You can move the toolbars to horizontal or vertical 
positions anywhere on the screen, and you can toggle them off and on by using the shortcut menu when the pointer is 
positioned over one of Rapid SQL's toolbars. For more information, see the following topics:

• Available toolbars

• Using toolbar viewing options

• Moving Toolbars

NOTE: For related information, see Customizing general user interface appearance.

Available toolbars
The following list represents Rapid SQL's toolbars:

Datasource Toolbar
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Registration Toolbar

Main Toolbar

Windows Toolbar

Tools Toolbar

Project Toolbar

SQL Edit Toolbar

Browsers Toolbar

Using toolbar viewing options
Rapid SQL offers standard Windows toolbar options such as docking, floating, and positioning toolbars.The only 
application-specific viewing option is the hiding or display of the individual toolbars.
EMBARCADERO TECHNOLOGIES>RAPID SQL® XE PRO AND RAPID SQL® 7.7 USER GUIDE 54



 > 
To hide or display a toolbar:
1 On the View menu, select Toolbars and then select the specific toolbar you want to display or hide.

For information on the toolbars available, see Available toolbars.

Moving Toolbars
1 Click the pointer at the right edge of any toolbar.

2 Drag the toolbar to the new position.

For more information, see Toolbars.

Customizing general user interface appearance
Rapid SQL lets you choose from a set of general visual application styles, dictate hiding or display of particular items, 
and select preferences for specific user interface elements.

To customize the general look and feel of Rapid SQL:
1 On the View menu, select Toolbars and then select Customize. The Customize dialog opens.

2 Use the following table as a guide to understanding and setting options on tabs of the Customize dialog:

Tab Settings and tasks

Toolbars Select the toolbars you want to display in the application. For information on the toolbars available, 
see Available toolbars.

Application Visual 
Style

Select a visual style such as Microsoft Windows XP or one of the .NET options from the dropdown. 
Depending on your selection, the following options may or may not be enabled: Use default 
WIndows XP colors, OneNote style tabs, Docking Tab Colors, Allow MDI Tab Swapping, 
Enable Smart Docking, Enable Tab Menu, and 3D Rounded Docking Tabs.

Menu animations Lets you specify a menu animation style of UNFOLD, SLIDE, or 
FADE.

Menu Shadows Displays shadowed 3D effects.

Tools Lets you define external applications to run from the Tools menu of Rapid SQL: the text displayed 
on the Tools menu command (Menu contents), the path and file name of the executable 
(Command), optional Arguments, and an optional Initial DIrectory.

For detailed information on providing arguements, see Specifying an Argument for a Tools Menu 
Command.

Keyboard Category Select a general category for a hot key for the command.

Commands Select a hot key command, based on the general category.

Description Displays the command description.

Set Accelerator for Select application area where you want new hot key to be active.

Current Keys Displays current hot key.

Press New Shortcut Key Press keyboard key or an unassigned F key.
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3 Click Apply at any time to implement any changes you have made and when finished, click Close.

Specifying an Argument for a Tools Menu Command
You can specify an argument to be passed to a program for newly added commands by choosing one of Rapid SQL's 
predefined arguments or entering a command-line argument.

The table below provides scenarios of how to use command-line arguments:

The table below provides scenarios of how to use Rapid SQL’s predefined arguments:

Options Show ScreenTips on 
toolbars

Select to display a ScreenTip when you hover your mouse over a 
button. For example, when you hover your mouse over the New 
button, Rapid SQL displays the ScreenTip “New.”

Show shortcut keys in 
ScreenTips

Select to display a shortcut key in the ScreenTip when you hover your 
mouse over a button. For example, when you hover your mouse over 
the New button, Rapid SQL displays the ScreenTip “New (CTRL+N).”

Command Argument Description

NOTEPAD.EXE $$FilePath$$ Starts Microsoft Notepad displaying the 
contents of the $$FilePath$$ 
argument.

ISQL.EXE -U$$CurUserID$$ -P$$CurPwd$$ 
-S$$CurConString$$ 
-i$$FilePath$$

Starts ISQL, automatically connects to 
the current datasource using the 
current user name and password, and 
executes the contents of $$FilePath$$.

SQLPLUS.EXE $$CurUserID$$/$$CurPwd$$@$$
CurConString$$ @$$FilePath$$

Starts SQL*Plus, connects to the 
current datasource using the current 
user name and password, and 
executes the contents of $$FilePath$$.

Argument Description

$$FilePath$$ The complete filename of the current source (defined as 
drive+path+filename); blank if a non-source window is active.

$$FileDir$$ The directory of the current source (defined as drive+path); blank if a 
non-source window is active.

$$FileName$$ The filename of the current source (defined as filename); blank if the 
non-source window is active.

$$FileExt$$ The filename extension of the current source; blank if a non-source 
window is active.

$$CurLine$$ The current cursor line position within the active window.

$$CurCol$$ The current cursor column position within the active window.

$$CurText$$ The current text (the word under the current cursor position, or the 
currently selected text, if there is one).

$$CurDir$$ The current working directory (defined as drive+path).

$$CurDatasource$$ The name of the current datasource as defined in Rapid SQL.

$$CurUserID$$ The name of the current datasource user.

Tab Settings and tasks
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Predefined Arguments
Rapid SQL provides a number of predefined arguments that you can pass to programs that you have added to the 
Tools menu. The table below lists the available predefined arguments:

NOTE: Arguments are case-sensitive.

Keyboard Shortcuts
Rapid SQL provides a number of keyboard shortcuts to help you expedite your tasks. The table below lists the taxes 
and related shortcuts:

$$CurPwd$$ The current datasource password.

$$CurConString$$ The current connection string or server name.

Argument Description

$$FilePath$$ The complete filename of the current source (defined as 
drive+path+filename); blank if a non-source window is active.

$$FileDir$$ The directory of the current source (defined as drive+path); blank if a 
non-source window is active.

$$FileName$$ The filename of the current source (defined as filename); blank if the 
non-source window is active.

$$FileExt$$ The filename extension of the current source; blank if a non-source 
window is active.

$$CurLine$$ The current cursor line position within the active window.

$$CurCol$$ The current cursor column position within the active window.

$$CurText$$ The current text (the word under the current cursor position, or the 
currently selected text, if there is one).

$$CurDir$$ The current working directory (defined as drive+path).

$$CurDatasource$$ The name of the current datasource as defined in Rapid SQL.

$$CurUserID$$ The name of the current datasource user.

$$CurPwd$$ The current datasource password.

$$CurConString$$ The current connection string or server name.

General Editing Keyboard Command

Delete one character to the left BACKSPACE

Delete one character to the right DELETE

Cut selected text to the Clipboard CTRL+X

Undo the last action CTRL+Z

Redo the last undo operation CTRL+Y

Copy text CTRL+C

Paste the Clipboard contents CTRL+V

Argument Description
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To Extend a Selection Keyboard Command

One character to the right SHIFT+RIGHT ARROW

One character to the left SHIFT+LEFT ARROW

To the end of a word CTRL+SHIFT+RIGHT ARROW

To the beginning of a word CTRL+SHIFT+LEFT ARROW

To the end of a line SHIFT+END

To the beginning of a line SHIFT+HOME

One line down SHIFT+DOWN ARROW

One screen up SHIFT+PAGE UP

To the beginning of a document CTRL+SHIFT+HOME

To the end of a document CTRL+SHIFT+END

To include the entire document CTRL+A

To Move the Insertion Point Keyboard Command

One character to the left LEFT ARROW

One character to the right RIGHT ARROW

One word to the left CTRL+LEFT ARROW

One word to the right CTRL+RIGHT ARROW

One line up UP ARROW

One line down DOWN ARROW

To the end of a line END

To the beginning of a line HOME

One screen up (scrolling) PAGE UP

One screen down (scrolling) PAGE DOWN

To the end of a document CTRL+END

To the beginning of a document CTRL+HOME

Bookmarks Keyboard Command

Toggle bookmark on/off CTRL+F2

Go to next bookmark F2

Go to previous bookmark SHIFT+F2

Splitter Windows Keyboard Command

Go to next pane F6
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Full Screen Mode
Rapid SQL has full screen mode capabilities so you can conceal the application framework and use the entire monitor 
area. Full screen mode hides any other applications running on the computer and uses every available pixel for the 
application. Main menu functionality is accessible through keyboard commands when you use full screen mode. 

Go to previous pane SHIFT+F6

Debugger Operations Keyboard Command

Start Debugging CTRL+F5

Stop Debugging SHIFT+F5

Step Over F10

Step Into F11

Run to Cursor CTRL+F10

Step Out SHIFT+F11

Describe from Cursor CTRL+D

Insert or Remove Breakpoint F9

Toggle (Enable or Disable) Breakpoint CTRL+F9

Edit Breakpoint ALT+F9

Go F5

Restart CTRL+SHIFT+F5

Debugger Windows Keyboard Command

Open or Close Watch Window ALT+3

Open or Close Variables Window ALT+4

Open or Close Call Stack Window ALT+5

Open or Close Dependency Tree Window ALT+6

Other Windows Keyboard Command

Go to the Result Tab CTRL+ALT+R

Go to the Query Tab CTRL+ALT+Q

Open the Describe window (for highlighted 
object)

CTRL+D

Toggle between Workspaces CTRL+W

Toggle between Datasource Explorer and 
ISQL Window.

CTRL+ALT+E

Splitter Windows Keyboard Command
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Activating Full Screen Mode
Rapid SQL offers two ways to activate full screen mode:

1 On the View menu, click Full Screen.

OR

On the Main toolbar, click Full Screen.

Rapid SQL expands the application to fit the entire monitor area.

NOTE: The Full Screen mode icon is a stand-alone floating toolbar.

Dismissing Full Screen Mode
1 Click Full Screen to expand the application to fit the entire monitor area.

TIP: If you closed the Full Screen mode toolbar, right-click the top of the Rapid SQL desktop to bring 
the toolbar back.

2 Click Full Screen to restore the application to the default size.
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Specifying Rapid SQL application and feature options
Rapid SQL lets you customize the application configuration for your specific needs. All Rapid SQL application settings 
are available in the Options Editor, which is organized in a tabular format based on feature sets. 

To specify options for the Rapid SQL application or a particular feature:
1 On the File menu, click Options. 

Rapid SQL opens the Options Editor.

2 Click the tab corresponding to the feature you want to customize:

Browsers options Lets you specify appearance of browser windows.

Code Analyst options Lets you set dependency profiling level, allram and threshold, and oracle options for Code 
Analyst.

Connection options Specifies the timeout parameters, packet size for a connection, and ANSI to OEM settings.

Data Editor options Specifies settings for Data Editor.

Data transfer options Sets default directories when performing data unload and load and data export and import 
operations. 

Explorer options Sets defaults for the organization of objects in the Datasource Explorer.

Datasource options Specifies general datasource management options and Datasource Explorer preferences.

DDL extract options Specifies whether or not Rapid SQL should include DROP statements when extracting the 
schema of different database object types.

Debug options Sets the duration of your debug initialization and debug session, enable or disable 
DBMS_OUTPUT, and enable the refresh option. 

Directories options Sets the default directories for placing the output of different operations such as HTML reports 
or schema extractions.

General options Sets defaults for automatic login, restoring the last session, and other general application 
options.

Grid properties (Results 
window) options

Dictates the physical appearance of the results window grid.

ISQL options Sets defaults for the maximum allowable errors before aborting the execution of a SQL script, 
executing selected text, and the position of Query and Results tabs.

Java options Specifies load Java files and drop Java files.

JDBC options Lets you specify Java Virtual Machine options in addition to the JDBC driver location for each 
platform.

Logging options Sets defaults for SQL Logging.

MySQL Utilities Options Specifies paths to MySQL utilities.

Oracle Utilities options Specifies the location of the Oracle Utilities.

Perf Center options Specifies Performance Center’s integration with Rapid SQL.

Query Builder options Specifies global settings for Query Builder.

Results (ISQL) options Specifies auto format result sets, sets the display and format of Result Windows, and the mail 
file type and default fonts.

SMTP mail options Lets you specify defaults for your outgoing mail notifications.

Version Control options Lets you select which version control system you want Rapid SQL to use as the underlying 
version control system
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3 Set feature options on the tab and then click OK.

NOTE: If there is an open document, Rapid SQL opens the Update Document Statement Properties 
dialog box. The Update Document Statement Properties dialog box lets you override changes you 
made to a current document or documents with new setting you made in the Options Editor.

Browsers options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Browsers tab.

The Browsers Tab of the Options Editor lets you set a number of options for your browser windows, including browser 
appearance, mail file type options, and default object owner.The table below describes Browser options: 

Warnings options Activates specific warnings when undesirable actions are attempted against a database.

Interface 
Element

Option Description Default

Window Show Toolbar Toggles the Browser window toolbar. Commands can also be 
activated from the shortcut menu that displays when you right-click in 
an open Browser window.

Selected

Show Status 
Bar

Toggles the status bar at the bottom of the Browser window. The 
status bar displays the cell location of the current focus and the 
number of rows in the Browser window itself.

Selected

Detailed Listing Toggles detail columns for a given object type. Each object contains 
object specific details, such as creation date, segment, and so on. 
When Detailed Listing is turned off, only the names of objects and the 
numbers of rows of data for a table are displayed.

Not 
selected

Appearance Text Color Sets the text color for all Browsers of that object type. Select the row 
appropriate to a particular object type, then click a color in the Text 
column. Remember that text colors appear best against contrasting 
background colors, such as black on white.

Available

Background 
Color

Sets the background color for all Browsers of that object type. Select 
the row appropriate to a particular object type, then click a color in the 
Background column. Remember that text colors appear best against 
contrasting background colors, such as black on white.

Available

Browser File Mail File Type Specifies what file type you want the browser file saved as when sent 
as e-mail to another user on a MAPI compliant mail system. The valid 
types are the proprietary Rapid SQL Results type, Tab delimited, 
Comma separated, and HTML, which formats the results in a simple 
HTML table.

Results

Default Owner All Owners Indicates that the Browser Window should default to displaying 
database objects in the browsers for all owners in the database.

Not 
Selected

Current User Indicates that the Browser Window should default to displaying 
database objects owned exclusively by the current user.

Selected

Specific Owner Indicates that the Browser Window should default to displaying only 
the database objects owned by a specific owner. If you select this 
option, you must provide an owner name in the box.

Not 
Selected
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Code Analyst options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can set preferences 
for Code Analyst. For information on how to use Code Analyst to identify time-consuming lines of code, see Code 
Analyst.

The table below describes Code Analyst options: 

Connection options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can configure a 
number of server parameters for interacting with your datasources on the Connection tab.

NOTE: Setting Connection Options are available for Microsoft SQL Server and Sybase ASE.

The table below describes the options and functionality on the Connection Tab:   

Group Options and descriptions

Dependency profiling 
level 

All Dependencies Code Analyst witll use all levels of dependencies when profiling 
the session.

Dependencies up to 
level

Lets you specify how many levels of dependencies the Code 
Analyst will use when profiling the session.

Oracle List Package objects Code Analyst lists the procedures within a package and functions 
that are found in the Oracle database.

Use SQL Profiler Code Anlsyt uses Oracle's DBMS_Profiler package to collect 
time metrics.

Code Analyst displays the actual run time on the database, and 
does not include the time it takes to get to the server. 

Alarms and Thresholds Lets you set an alarm for each type of object that is collected. For each supported Object 
Type (procedure, function, package, trigger, type), you can provide the following settings:

Alarm % - lets you specify the percentage of total run time a line of code takes when an alarm 
appears. If the object took more than specified percent of total time, Code Analyst alerts the 
user by changing the color of the text

Ignore 100% - lets you ignore lines of code that take all of the total run time

Show Code Analyst 
Confirmation Dialog

When you create or execute a session, Code Analyst displays a message that the Code 
Analyst will run longer than the actual code. You can also select the "Please do not show me 
this dialog again" option in the dialog box. 

Option Description Default

Login Timeout Specifies the number of seconds that the application should wait for a response to a 
connection request from server. If server does not respond within the specified period, the 
application aborts the connection and returns an error message.

30

Query Timeout Specifies the number of seconds that the application should wait for a response to a query 
from the server. If the server does not respond within the specified period, the application 
terminates its query process and returns an error.

0

Packet Size Specifies the network packet size to be used when communicating with the server, in bytes. 512

Max 
Connections 
(ctlib)

The maximum number of connections allowed by the ctlib setting on the client. 0
EMBARCADERO TECHNOLOGIES > RAPID SQL® XE PRO AND RAPID SQL® 7.7 USER GUIDE 63



 > 
Data Editor options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Data Editor tab.

NOTE: Option parameters set in the Options Editor override options set within Query Builder and Data 
Editor. 

The table below describes the options and functionality on the Data Editor Tab:

Client 
Character Set

Character set of client computer. Local 
character 
set

Host Name Name of the client computer. Local 
name

Use Quoted 
Identifiers

If you plan to use delimited identifiers, select this option. Not 
selected

Interface Element Option Description Default

Default Execution 
Mode

Live Mode lets you execute changes one row at a time. Batch Mode lets you 
make unlimited changes prior to execution. Batch Mode offers three sub-options: 
Ignore errors-continue processing, Prompt on Error, and Stop after error(s) 
(number of errors allowed before stopping execution)

Live Mode

Data Editor File Mail File Type Sets the default mail output style as Results, Tab 
Delimited, Comma Separated, or HTML.

Results

Include column titles 
when saving

Includes column titles when saving. Not selected

Grid Font Customizes font style, and size for the Data Editor and the Results Grid. Available

Printer Font Sets font style, and size for printing output. Available

Auto Format (Best 
Fit)

Fits formatting to match your desktop. Selected

Begin and End 
Transaction 
Statements

Adds a beginning and ending transaction on each statement. Selected

Default Date/Time 
Format

Displays the current date/time format and lets you customize the date/time 
display.

Results

Use Calendar Control 
as default

If selected, Rapid SQL uses the Calendar Control 
window. 

Not selected

2 digit year system 
setting warning

If selected, Rapid SQL sends a warning when you use 
a two digit year system setting.

Selected

Confirmation 
Dialog Options

Enabling Show Delete Confirmation Dialog, Show Update Confirmation 
Dialog, or Show Update LOB Confirmation Dialog lets you display a 
confirmation dialog box when you use a delete command, update a row, or 
update a LOB, repectively..

Selected

Option Description Default
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Data transfer options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Data Transfer tab.

You can configure Rapid SQL to use default directories when performing data unload and load and data export and 
import operations. Setting a default directory saves time because it describes a single reference point for loading or 
unloading, exporting and importing table or view data files. 

The table below describes the options and functionality on the Data Transfer Tab: 

Datasource options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Datasource tab. The table below describes the options and functionality on the Datasource Tab:  

Option Description

Data Unload Specifies the name and location of the default directory in the Data Unload box.

Data Load Specifies the name and location of the default directory in the Data Load box. 

Oracle Export (for Oracle) Specifies the name and location of the default directory in the Oracle Export box.

Oracle Import (for Oracle) Specifies the name and location of the default directory in the Oracle Import box.

Option Description Default

Datasource Storage 
Management

Rapid SQL offers both registry-based and file-based datasource catalog 
management. Prior to changing methods, see Understanding the Datasource 
Catalog.

The following options are offered:

Windows Registry datasource catalog - The datasource catalog is stored 
and managed locally, in the Windows registry. This user can add and delete 
datasources and edit the registration details of existing resources. Any changes 
are retained across startups of Rapid SQL.

File based datasource catalog - The datasource catalog is stored locally and 
is file-based (%APPDATA%\Embarcadero\Data Sources\ in a default 
installation). This user can add and delete datasources and edit the registration 
details of existing resources. Any changes are retained across startups of Rapid 
SQL. 

Network shared datasource catalog - The datasource catalog is file-based, 
and obtained from the location specified in the Location of shared 
datasources file control. Changes such as new datasources, deleted 
datasources or edited datasource registrations are lost as soon as this user 
shuts down Rapid SQL. 

Changing methods does not delete datasource definitions stored using the 
current method. When you change methods, Rapid SQL does not automatically 
convert existing catalog definitions to the new method

Windows 
Registry

Recent Datasource List 
Contains

Lets you specify number of datasources to display when you select Recent 
Datasources from the File menu.

8

Default to Alias Usage 
When Defining New 
Datasources

For DBMS that support alias usage, defaults the Connection Information tab 
to alias usage selection.

Unselected
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DDL extract options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the DDL Extract tab.The DDL Extraction Tab of the Options Editor lets you specify common and DBMS-specific 
DDL Extract options.

Common options
The table below describes the options and functionality on the DDL Extract Tab, main view, of the Options Editor:

DBMS-specific DDL Extract options
The DBMS-specific views of the DDL Extract tab let you specify:

• The object types to include DROP statements for

• The default dependent object types for each object type included in extraction/migration operations

Datasource Category 
Settings

Lets you select the optional user interface elements that are to be color-coded 
or labelled for datasources that have been assigned a category:

Color the status bar using the datasource’s category color
Color the tabs using the datasource’s category color
Include category short name in the datasource toolbar combo
 For an introduction to datasource categorization and related tasks, see 
Categorizing datasources using color-coding and labelling. 

N/A

Option Description

Extract to multiple 
windows

Select to extract the schema for each object into separate DDL windows.

NOTE: This option only works when you extract DDL for multiple objects.

Extract in dependency 
order

This is the default. 

When you select a number of objects as part of an extraction job, this option ensures objects 
will be extracted in the proper dependency order.

If the option is not selected, errors may result when you execute the script.

It’s also true, however, that loading the dependencies can add significant overhead when you 
are extracting numerous objects. 

Script Use Statement This option is for Sybase. Optimizes extraction through generating Use statements in the 
generated script.

Grouping Extracted DDL There are two option as to how the DDL is generated for an extract operation:

Group the Drop and Create DDL for each object together - Objects are extracted one at a 
time. In the DDL generated by the extract, the Drop statement for a selected or referenced 
object is followed by the Create statement for that object.

Group DDL statements by type - all Drop statements, then all Create statements - In the 
DDL generated by the extract, Drop statements for all selected or referenced objects are 
grouped to precede Create statements for those objects. This method ensures that all 
dependencies are respected.

For more information on DROP options and dependencies, see DBMS-specific DDL Extract 
options.

Option Description Default
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You can choose to include DROP statements before you perform ad hoc DDL extractions. You can use this feature to 
modify and to re-compile database objects. To recompile a database object, drop it before recreating it. This option 
drops any existing objects of the same name before recreating the object. The data in the existing table is not saved 
when you specify a DROP statement for extracted DDL. 

CAUTION: Because dropping an object is a destructive action, you should carefully consider including drop 
statements before activating this option.

You can also specify dependent object types included in extraction/migration operations. Each DBMS-specific view of 
the DDL Extract tab lets you specify the object dependencies for each object type. Dependent object types selected 
on that view are by default selected when you run an extraction/migration operation and can be overridden using 
those wizards. For more information see Extract.

Debug options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Debug tab. The Debug Tab of the Options Editor lets you set the duration of your debug initialization and debug 
session, enable or disable DBMS_OUTPUT, and enable the refresh option. 

The table below describes the options and functionality on the Debug Tab: 

Tab Option Description Default 

General Dependency Tree 
Option

Lets you specify pre-fetch levels. Pre-Fetch All 
Dependencies

Profiler Profiler Time Unit Lets you select a unit of milliseconds, seconds or minutes. Milliseconds

Save Profiler Reports Lets you save profiler reports and type or browse for the report 
path.

Not Selected

Oracle Initialization Timeout 
(seconds)

Specifies the point at which the application stops trying to 
initialize the debugger. If it cannot initialize the debugger in the 
specified time, it displays message in the Debug Output window. 

60 

Debug Session Timeout 
(seconds)

Specifies the point at which the application terminates your 
debug session due to idle time.

7200 

Enable DBMS Output Enables the Oracle built-in package, DBMS_OUTPUT, letting you 
send messages from stored procedures, packages, and triggers. 

Selected 

Refresh Dependencies 
for each run

Refreshes the dependencies each time you run the debugger. Not selected 

Compile with Debug 
Option

When debugging a procedure against an Oracle datasource, 
Rapid SQL performs a compilation before debugging.  During a 
compilation, Oracle invalidates referencing objects.  For 
example, if procedures A2 and A3 both reference procedure A1, 
debugging procedure A1 in Rapid SQL, will result in procedures 
A2 and A3 being marked as invalidated.

The Compile with Debug Options settings let you control 
compilation of dependent objects while debugging.

Compile 
dependent 
options

DB2 Debug Session Timeout 
(seconds)

Specifies the point at which the application terminates your 
debug session due to idle time.

300

Compile with Debug 
Option before Debug 
Session

Lets you specify options. Prompt Always
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Directories options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Directory tab. Rapid SQL lets you configure Directory Options to use default directories when performing 
certain operations. You can set the default directories for: 

• Wizard operations 

• Report generation 

• Schema extraction 

• HTML templates for customizing reports 

The table below describes the options and functionality on the Directories Tab:  

Explorer options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Explorer tab. The Explorer Tab of the Options Editor lets you configure how objects are organized in the 
Datasource Explorer.

Option Description Default

Wizard 
Definitions

Specifies the name and location of the default directory for saving 
wizard operations. This option applies to wizard operations in 
which you have the option to save the definition file, such as data 
unload/load or schema migration operations.

C:\Documents and Settings\user 
name\Application 
Data\Embarcadero\RapidSQL\DefFiles

HTML 
Reports

Specifies the name and location of the default directory for the 
output from generated HTML reports.

C:\Documents and Settings\user 
namer\Application 
Data\Embarcadero\RapidSQL\Report

Schema 
Extraction

Specifies the name and location of the default directory for 
placing the output from schema extraction operations. 

C:\Documents and Settings\user 
name\Application 
Data\Embarcadero\RapidSQL\Extract

HTML 
Template

Specifies the name and location of the default directory where 
DBArtisan can find the HTML template on which to base HTML 
reports. This feature lets you customize your HTML reports. 

C:\Program 
Files\Embarcadero\RSQL770\HtmlTpl

User SQL 
Scripts

Specifies the name and location of the default directory for SQL 
Scripts.

C:\Documents and Settings\user 
name\Application 
Data\Embarcadero\RapidSQL\UserSQ
LScripts

Job Config 
Files

Specifies the location of any ETSQLX job configuration files you 
have set on your local machine.

C:\Documents and Settings\davidt\My 
Documents\Embarcadero\RapidSQL\
Directories\ETSQLXJobCfg

#include 
Files

Specifies the name and location of the directory searched for files 
specified by a #include directive in the ISQL editor, Procedure 
Object Editor, or Package Body Object Editor if there are no 
paths specified on the Datasource Properties tab of the 
Datasource Registration Editor. For more information, see 
Registering or editing datasources.

C:\Documents and Settings\davidt\My 
Documents\Embarcadero\RapidSQL\
Directories\IncludeFiles
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The table below describes the options and functionality on the Explorer Tab:

General options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the General tab. The General tab of the Options Editor lets you specify general application options. The table below 
describes the options and functionality on the General Tab:  

Option Description Default

Explorer organization Lets you select a default grouping option of Organize by Object Owner 
(groups objects, by object type, for each user) or Organize by Object 
Type (groups objects by object type for all users in the same list). Grouping 
by object owner is most efficient if you are working with databases 
containing a high number of objects.

You can change the organization manually during a Rapid SQL session. 
For details, see Explorer Tab.

Owner

Show System Objects 
and Show Only My 
Objects (available if you 
are organizing the 
Datasource Explorer by 
object type)

Lets you select a default Datasource Explorer tree display options for 
system objects and objects that you own. Available options in the two 
groups are:

Never - the relevant objects are not displayed by default.

Always - the relevant objects are always displayed by default.

Use datasource filter - The relevant default datasource filter is enabled. 
For more information, see Filters Node.

You can change the Show System Objects and Show Only My Objects 
settings manually during a Rapid SQL session.. For details, see Using the 
default filters.

N/A

Options Lets you anble or dispble the following settings:

Refresh after Object Commands - Refreshes the Explorer automatically 
after an object has been modified or created.

Retain View Setting on Close - Select to retain the current state of the 
Datasource Explorer so that it opens the same way the next time you start 
Rapid SQL. 

N/A

Tab Option Description Default

Main tab Confirm on Exit Instructs Rapid SQL to issue a message confirming the 
operation before exiting the application.

Selected

Max Editors in a 
Single Open 
Operation

Specifies the maximum number of editors allowable from a 
single Open operation.

5

Max Entries in 
Output Window

Specifies the maximum number of messages that can appear 
in the Output Window before the contents are flushed. This 
option conserves memory resources. You can clear the Output 
window or raise the maximum number allowed at any time.

1500
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Grid properties (Results window) options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Grid Properties tab.

The Grid Properties tab of the Option editor lets you set preferences for the layout and appearance of the grid in an 
Results window. The table below describes the options and functionality on the Grid Properties tab:

ISQL options
The ISQL options are available on the following tabs:

• ISQL options - Main tab

• ISQL options - Oracle tab

• ISQL options - DB2 tab

• ISQL options - Sybase tab

• ISQL options - SQL Server tab

• ISQL options - MySQL tab

Oracle Data Dictionary 
View Usage

Lets you synchronize Rapid SQL use of the Oracle Data Dictionary DBA and 
ALL/USER views with the privileges associated with the role used in creating 
and using the datasource.

Role-based Views - Rapid SQL will use views based on the user’s role. That is, 
users with DBA privileges will use DBA views.

DBA Views - Rapid SQL always uses DBA views.

All Views - Rapid SQL always uses ALL views.

Use Datasource Configuration for Views - lets you set up Data Dictionary 
usage on a view-by-view basis when editing or registering a datasource.  For 
more information, see Registering or editing datasources.

Preserve Case in 
Object Identifiers

Preserves case of the database object. Not selected

Sybase and 
SQL Server

Rename action style Lets you specify whether user-defined objects or dataypes are 
renamed using an extended ALTER or using the sp_rename 
procedure. 

extended 
alter

InterBase/Fireb
ird

Preserve Case in 
Object Identifiers

Preserves case of the database object. Not selected

Interface Element Options and descriptions Default

Titles and Gridlines 3D-Buttons Enables or disables a 3-D appearance on row and column 
headings in the grid.

Set

Horizontal Gridlines Enables or disables ruling between rows of the grid. Set

Vertical Gridlines Enables or disables ruling between columns of the grid. Set

Mark Headings Enables or disables highlighted row and column headings. Set

Preview Displays a preview of the settings currently selected in the TItles and Gridlines group.

Tab Option Description Default
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• ISQL options - DB2 OS390 tab

• ISQL options - InterBase tab

• ISQL options - Editor tab

• ISQL options - Auto format tab

• ISQL options - Index Manager tab

• ISQL options - Code Assist tab

ISQL options - Main tab
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the main tab of the ISQL pane. Use the following table as a guide to modifying settings on this tab:

ISQL options - Oracle tab
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Oracle tab of the ISQL pane. Use the following table as a guide to modifying settings on this tab:

Max Errors Before 
Aborting Execution

Sets the maximum number of errors allowed before aborting the execution of a script. A zero 
indicates that the option is inactive and that you recognize no limit to the number of errors 
allowed. Rapid SQL refers to this value when step executing SQL scripts.

Execute Selected Text Executes a portion of a selected SQL script.

Check Syntax When 
Executing

For DB2, required to execute DB2 call statements in the ISQL Window.

Automatically lock 
connection

When disabled, a prompt to commit or rollback the transaction is displayed when you close the 
ISQL editor window. Enabling this options disables the prompts and locks the connection 
automatically.

Prompt to lock database 
connection

Locks the database connection on execution.

Tabs Sets the appearance of the ISQL Window tabs to either the top or bottom of the ISQL Window.

File Association Specifies whether the application should open an unknown file type automatically into an ISQL 
Window or prompt you with a message that Rapid SQL does not recognize the file type.

Query Plan Layout Sets the default orientation of a graphical query plan. For more information, see Query 
options.

Option Description

Enable DBMS Output Lets you specify Buffer size. 0 is the default.

Auto-Commit changes Applies auto commit status changes to all open windows.

View xmltype as clob When enabled, xmltype columns are displayed as CLOBs in the Results grid and the Data 
editor. Without this option selected, SELECT statements that qualify xmltype columns produce 
an OciTypeBinder conversion error. With the option selected, the SELECT submitted by 
Rapid SQL is modified to include a getclobval() method call.

Default Query Plan Lets you select the default display, tree-based or graphical, when you generate a query plan. 
For more information, see Viewing a graphical Query Plan (Oracle).
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ISQL options - DB2 tab
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the DB2 tab of the ISQL pane. Use the following table as a guide to modifying settings on this tab:

ISQL options - Sybase tab
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Sybase tab of the ISQL pane. Use the following table as a guide to modifying settings on this tab:

Load Query Options If this option is not enabled, Rapid SQL loads a set of default query options that customize 
your execution environment, and periodically sends those settings to the server. Enabling this 
option and specifying an XML file, forces Rapid SQL to load a previously saved query options 
file each time an ISQL windows opens against this DBMS platform. This lets you override 
Rapid SQL’s default query options.

You can also enable this option when saving a query options file. For information on other load 
and save options, specific query options offered, manually updating query options, and 
conditions for which query options are sent to the server, see Query options. 

Option Description

Set Isolation Level Sets the default for the value of the Isolation Level option on the Query Options dialog. For 
details, see Query options.

Auto-Commit changes Applies auto commit status changes to all open windows.

Create Explain plan 
tables if required

If set to TRUE, Explain Plan tables are created, as necessary. If set to FALSE and you don’t 
manually create tables, Explain Plan operations will fail.

Create explain plan 
tables on the 
SYSTOOLS schema

If set to TRUE, Explain Plan tables are created on the SYSTOOLS schema. If the tables 
already exist in the user’s default schema, Rapid SQL continues to use those tables. Refer to 
DB2 documentation for a listing of Explain Plan tables that must be deleted in order to use the 
SYSTOOLS option. If set to FALSE, Explain Plan tables are created under the user’s default 
schema.

Load Query Options If this option is not enabled, Rapid SQL loads a set of default query options that customize 
your execution environment, and periodically sends those settings to the server. Enabling this 
option and specifying an XML file, forces Rapid SQL to load a previously saved query options 
file each time an ISQL windows opens against this DBMS platform. This lets you override 
Rapid SQL’s default query options.

You can also enable this option when saving a query options file. For information on other load 
and save options, specific query options offered, manually updating query options, and 
conditions for which query options are sent to the server, see Query options. 

Option Description

Auto-Commit changes Applies auto commit status changes to all open windows.

Load Query Options If this option is not enabled, Rapid SQL loads a set of default query options that customize 
your execution environment, and periodically sends those settings to the server. Enabling this 
option and specifying an XML file, forces Rapid SQL to load a previously saved query options 
file each time an ISQL windows opens against this DBMS platform. This lets you override 
Rapid SQL’s default query options.

You can also enable this option when saving a query options file. For information on other load 
and save options, specific query options offered, manually updating query options, and 
conditions for which query options are sent to the server, see Query options. 

Option Description
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ISQL options - SQL Server tab
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the SQL Server tab of the ISQL pane. Use the following table as a guide to modifying settings on this tab:

ISQL options - MySQL tab
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the MySQL tab of the ISQL pane. Use the following table as a guide to modifying settings on this tab:

ISQL options - DB2 OS390 tab
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the DB2 OS390 tab of the ISQL pane. Use the following table as a guide to modifying settings on this tab:

Option Description

Enable Set Query 
Options

Sets the default value of the Send Set Options setting on the Query Options dialog. For 
details, see Query options. Changing this value does not affect ISQL sessions currently open.

Auto-Commit changes Applies auto commit status changes to all open windows.

Load Query Options If this option is not enabled, Rapid SQL loads a set of default query options that customize 
your execution environment, and periodically sends those settings to the server. Enabling this 
option and specifying an XML file, forces Rapid SQL to load a previously saved query options 
file each time an ISQL windows opens against this DBMS platform. This lets you override 
Rapid SQL’s default query options.

You can also enable this option when saving a query options file. For information on other load 
and save options, specific query options offered, manually updating query options, and 
conditions for which query options are sent to the server, see Query options.

Option Description

Load Query Options If this option is not enabled, Rapid SQL loads a set of default query options that customize 
your execution environment, and periodically sends those settings to the server. Enabling this 
option and specifying an XML file, forces Rapid SQL to load a previously saved query options 
file each time an ISQL windows opens against this DBMS platform. This lets you override 
Rapid SQL’s default query options.

You can also enable this option when saving a query options file. For information on other load 
and save options, specific query options offered, manually updating query options, and 
conditions for which query options are sent to the server, see Query options.

Option Description

Load Query Options If this option is not enabled, Rapid SQL loads a set of default query options that customize 
your execution environment, and periodically sends those settings to the server. Enabling this 
option and specifying an XML file, forces Rapid SQL to load a previously saved query options 
file each time an ISQL windows opens against this DBMS platform. This lets you override 
Rapid SQL’s default query options.

You can also enable this option when saving a query options file. For information on other load 
and save options, specific query options offered, manually updating query options, and 
conditions for which query options are sent to the server, see Query options.
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ISQL options - InterBase tab
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Interbase tab of the ISQL pane. Use the following table as a guide to modifying settings on this tab:

ISQL options - Editor tab
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Editor tab of the ISQL pane. The table below describes the options and functionality on the Editor Tab:   

Option Description

Load Query Options If this option is not enabled, Rapid SQL loads a set of default query options that customize 
your execution environment, and periodically sends those settings to the server. Enabling this 
option and specifying an XML file, forces Rapid SQL to load a previously saved query options 
file each time an ISQL windows opens against this DBMS platform. This lets you override 
Rapid SQL’s default query options.

You can also enable this option when saving a query options file. For information on other load 
and save options, specific query options offered, manually updating query options, and 
conditions for which query options are sent to the server, see Query options.

Group Option Description Default

Window Show Toolbar 
and Show 
Status Bar

Enables/disables these ISQL Window user interface elements. Selected

Maximize on 
new or open

Indicates that Rapid SQL should maximize the ISQL Editor. If you already 
have an active MDI Window that is maximized, the default behavior is to 
maximize a new child window. To deactivate this option, ensure you do not 
have any active MDI Windows, such as the Explorer.

Selected

File Tracking Indicates that the ISQL Editor should use the File Tracking Facility to 
monitor the status of a file. If a file has been modified and saved outside 
the application, the application loads the most current version of the file 
into the IISQL Editor based on the options set for Auto-Reload File (see 
above.)

Selected

Auto-Reload 
File

If File Tracking is enabled, indicates that the application should 
automatically reload a file that has been externally modified without 
prompting you. If you turn this option off, Rapid SQL prompts you before 
reloading your file if external changes have been saved.

Not 
selected

Auto-Save File Indicates that files in the ISQL Editor should automatically be saved at the 
indicated time interval. Backup files are saved to C:\Documents and 
Settings\username\Application 
Data\Embarcadero\RApidSQL\Backup\.
Backup files use a naming convention of the form ~ETxxxx.tmp., See the 
registry under 
HKEY_CURRENT_USER\Software\Embarcadero\RApidSQL\version\B
ackup for a listing of backup file names and the path of the file to which 
they correspond.

Selected 
(5 minutes)

Command 
History

Save File 
Before 
Overwriting

Specifies the action you want the application to take when selecting a 
command from the Command History box. You have the option to be 
reminded to save a file before overwriting (Ask First), to automatically save 
a file before overwriting (Always), or to automatically overwrite the file with 
the command (Never).

Ask First
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ISQL options - Auto format tab
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Auto Format tab. of the ISQL pane.

The Auto Format tab lets you specify the style and spacing of SQL statements in an ISQL window when you choose 
to auto format SQL in the ISQL editor.

On opening, the Preview area shows an SQL statement formatted according to the current Auto Format settings. Click 
Edit to open the Auto Format Options dialog. Use the following table as a guide to understanding and modifying the 
settings in this dialog:

Save Most 
Recent 

Specifies the number of commands you want to save in the Command 
History list in the top of the ISQL Window toolbar. The maximum value is 
99.

15

Printing Lets you select common printer options.

Appearance Enable Syntax 
Highlighting

Sets syntax highlighting on so that all keywords and comments are colored 
for easier reading and debugging.

Selected

Show Line 
Numbers

Places line numbers in the left column of an ISQL Window. Selected

Enable 
Outlining

Enables and disables outlining. Selected

Enable Text 
Wrapping

Enables and disables a typical text wrap feature. Selected

Editor Font Sets the font face, style, and size displayed in the editor. Available

Syntax Colors Sets syntax coloring for keywords, comments, quotes, and default text for 
various file types and scripts from the Syntax Coloring dialog box.

Available

Formatting Auto Indent Sets automatic indentation for each carriage return, new line in your SQL 
script.

Selected

Expand Tabs 
and Tab Size

Sets tabs as the specified number of spaces in result sets. Selected 
(4)

Setting Description

Keywords Lets you select a character case (UPPERCASE, LOWERCASE, INITIALCAPS, or NOCHANGE) 
formatting treatment for SQL keywords.

Right Margin Specifies the maximum number of characters per line.

New line before 
keyword

If enabled, a new line is forced before every SQL keyword. If disabled, lines are only forced for 
statement type and clause type keywords.

BEGIN..END block If enabled, empty BEGIN..END blocks occupy a single line.

Stack lists If enabled, a new line and indenting is forced for each item in comma-separated list such as 
argument lists.

List indent size If Stack lists is enabled, this control lets you specify the number of spaces each list item will be 
indented from the current offset.

Parenthesis indent 
size

Lets you specify the number of indenting spaces for forced lines following an open parenthesis.

Group Option Description Default
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When finished, click OK.

ISQL options - Index Manager tab
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the ISQL - Index Manager tab. 

The datasource index stores information required to resolve references to the tables, table columns, views, functions, 
procedures, packages, and synonyms for registered datasources. Required to support object name-based features 
such as Semantic Validation and Code Complete, the datasource index provides rapid lookup and assists in 
verification of object names.

NOTE: For information on the features requiring datasource index support, see Code Assist.

When indexing is enabled, Rapid SQL automatically builds and incrementally maintains the datasource index as 
follows:

• When you connect to a datasource that is currently unindexed, Rapid SQL will update the index with entries for 
the new datasource

• The index is automatically updated with any Rapid SQL operation that results in an ALTER, CREATE, DROP, 
RENAME, or EXECUTE action

• The index is automatically updated on a Rapid SQL Refresh operation against object types that support that 
operation

In addition, the datasource index stores a timestamp at the object type level for each datasource. When you connect 
to a datasource for which a time stamp for any object type is older than the specified Index expiration time, new 
index entries for all objects of that type on the datasource are generated.

While the datasource index is largely self-maintaining, the Options editor’s ISQL - Index Manager tab provides 
controls for manual maintenance of the index. You can clear the existing index, start creating a new index after 
clearing, and stop the indexing process. Typically, you only use these options in problem-solving and for manual 
intervention.

The table below describes the options and functionality on the ISQL - Index Manager tab. 

Conditions format 
style

Specifies how conditions in clauses are formatted:

CONDITIONS_WRAPPED - lines are not forced before conditions.

CONDITIONS_STACKED_WITH_LEADING_OPERATORS - a new line is forced for each 
condition in a clause, with logical operators, if present for a line, displayed at the start of the line.

CONDITIONS_STACKED_WITH_TRAILING_OPERATORS - a new line is forced for each 
condition in a clause, with logical operators, if present for a line, displayed at the end of the line.

Conditions stack 
threshold

For Conditions format style selections that specify stacking, this value specifies the minimum 
number of conditions that must appear in a clause before conditions are stacked.

THEN statements If enabled, simple THEN clauses are kept to a single line.

Option Description

Enable Indexing Enables the datasource indexing feature. Manual and automatic indexing updates cannot be 
executed unless this feature is enabled.

Log SQL This setting lets you enable or disable writing of the the SQL issued to create and maintain 
indexes to the SQL log.

Setting Description
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ISQL options - Code Assist tab
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Code Assist tab of the ISQL pane. Use the following table as a guide to modifying settings on this tab:

Start Indexing Updates the datasource index entries for the current datasource if entries exist for the 
connected datasource in the index. If no entries are present in the index, new entries for the 
datasource are created in the index.

Stop Indexing Stops any automatic indexing updates currently in progress.

Objects to index For objects not indexed, Code Assist features will not be available for those object types. 
Semantic validation applies to tables, views, columns, and synonyms. Code Complete applies 
to functions, procedures, packages, tables, views, columns, and synonyms. 

Clear Index Deletes the current datasource index. Automatic index updates, such as when connecting to a 
new datasource or making a subsequent change to the connected datasource, will commence 
immediately. You can also start indexing the entire datasource to which you are connected, 
using the Start Indexing button.

Index expiration time When an object type timestamp older than this value is detected on a datasource, Rapid SQL 
updates the index for all objects of that type on the datasource.

Index location Specifies the location of the files used to store the datasource index. A change to the location 
results in a new index being created next time that the application is started.

Group Option Description

SQL Assist Enable auto-activation 
and Auto-activation delay

When auto-activation is disabled, the Code Complete feature must be 
invoked manually. When auto-activation is enabled, the Code Complete 
feature is invoked automatically each time the interval between 
keystrokes exceeds the specified Auto-activation delay.. For more 
information, see Code Assist.

Insert single proposals 
automatically

Specifies that if a Code Complete suggestion list would contain only a 
single suggestion, that suggestion is inserted automatically.

Fully qualify completions 
automatically

Specifies that code completion results are returned fully qualified, rather 
than the minimum required to identify the object.

Semantic 
Validation

Severity levels for 
semantic validation 
problems

Lets you select the severity level (ERROR, WARNING, or IGNORE) 
associated with detected semantic errors. The default, WARNING, 
provides a contrast to syntax errors, which are always flagged with a 
severity level of ERROR.The IGNORE setting disables the feature. For 
more information, see About semantic validation.

SQL Parsing Enable Parsing SQL Parsing must be enabled if you are using features such as on-the-fly 
syntax checking, semantic validation, and Code Complete.

Parse always If SQL Parsing is enabled, enabling this option ensures that SQL Parsing 
is always active.

Parse based on file size 
and Maximum file size

If SQL Parsing is enabled, these options place an upper limit on file size. 
SQL Parsing for a file will be disabled when a file exceeds the specified 
size.

Option Description
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Java options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Java tab. The table below describes the options and functionality on the Java Tab:

NOTE: Options differ by platform. 

JDBC options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the JDBC tab.

Rapid SQL requires a JDBC connection. You have the ability, with this panel of the Options Editor, to set or change 
options that apply to platform-specific JDBC drivers and to the Java virtual machine (JVM) that is running on the client. 
The table below describes the options and functionality of the JDBC tab:

Interface 
Element

Option Description Default

Load Java files Use the DBMS_JAVA package Lets you schedule your SQL. Selected

Use batch file 
(oracle_home/bin/loadJava.bat)

Uses batch file (oracle_home/bin/loadJava.bat) Not 
selected

Default Encoding option Leave blank to use the default. Default

Drop Java files Use the DBMS_JAVA package Lets you schedule your SQL. Selected

Use batch file 
(oracle_home/bin/dropJava.bat)

Uses batch file (oracle_home/bin/dropJava.bat) Not 
selected

Option Description Default

JVM Options:

Initial Heap Size Set the size, in MB, for the repository where live and dead objects comingle with free 
memory. If memory runs out, JVM executions stop so the garbage can be collected 
and expunged. Each platform responds differently, so trial and error can help you 
maximize performance

64 MB

Maximum Heap Size Set the upper limit for your heap size. 64 MB

Additional Options Add options here ONLY in consultation with Embarcadero Technical Support N/A

Default JDBC Driver

DBMS Type Select the DBMS appropriate to the driver you want to review/adjust from the 
drop-down list.

Search Click ... to open the JDBC Driver Editor where you can see what drivers for the given 
platform are available to you. You can assign the JDBC Driver you selected as a 
default for all platform-specific datasources. 

Sybase

JConnect metadata 
procedures are 
installed on all servers

NOTE: Sybase documentation recommends that if you have transactional 
components that use jConnect caches, you need to make sure the jConnect 
Database Metadata stored procedures are installed on the database server. Please 
consult Sybase documentation for more information.
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Logging options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Logging tab. The Logging tab lets you set defaults that specify the behavior and placement of SQL Logging 
and Output Logging. 

The table below describes the options and functionality on the Logging Tab:   

MySQL Utilities Options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the MySQL Utilities tab. Rapid SQL integrates with MySQL utilities. For Rapid SQL to access these utilities, you 
need to specify their location in the MySQL Utilities Tab of the Options Editor. You can use the MySQL Dump and 
Import Utilities. The table below describes the options and functionality on the MySQL Utilities Tab 

Oracle Utilities options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Oracle Utilities tab.

Option Description Default

Log all SQL 
Statements to 
a File

Indicates that the application should log all of the SQL that it executes to a file. SQL logging 
provides an audit trail for Rapid SQL. You can examine this log to determine the SQL 
executed to complete a task.

Not 
selected

Logfile Path If you choose to log the SQL generated by the application, specify the drive, directory, and file 
name.

None

Max File Size Specifies the maximum size for the logfile. When the logfile reaches this threshold, it 
automatically starts deleting lines in the logfile (starting with the oldest statements) to remain 
within the specified size limit.

1024 KB

Truncate Empties the entire contents of the logfile. Not 
available

Log all 
Output 
Messages to 
a File

Indicates that the application should log all server messages sent to the Output window. This 
type of logging lets you monitor only messages issued by the server versus all SQL logged by 
the application. You can examine this log to determine all messages the server issued.

Not 
selected

Logfile Path If you choose to log the server messages generated in the Output window, specify the drive, 
directory, and file name.

None

Max File Size Specifies the maximum size for the output logfile. When the output logfile reaches this 
threshold, it automatically starts deleting lines in the file (starting with the oldest statements) 
to remain within the specified size limit.

1024 KB

Truncate Empties the entire contents of the output logfile. Not 
available

Option Description

mysqldump Specifies a path for the MySQL dump utility, mysqldump.exe. By default, MySQL installs this utility in the 
C:\mysql\bin directory.

mysqlimport Specifies a path for the MySQL import utility, mysqlimport.exe. By default, MySQL installs this utility in 
the C:\mysql\bin directory.
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Rapid SQL integrates with multiple Oracle utilities. For Rapid SQL to access these utilities, you need to specify their 
location in the Oracle Utilities Tab of the Options Editor. You can use the Oracle Export, Import Utilities, and SQL * 
Loader. The table below describes the options and functionality on the Oracle Utilities Tab: 

Perf Center options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Performance Center tab. Rapid SQL lets you customize Performance Center’s integration with Rapid SQL. 
The table below describes the options and functionality on the Perf Center Tab: 

Query Builder options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Query Builder tab. Option parameters set on the Options Editor elicit a prompt if there are different options set 
on an open individual session. Global options override properties set within individual Query Builder sessions. 

The table below describes the options and functionality on the Query Builder Tab: 

Option Description

Export Specifies a path for the Oracle Export utility. By default, Oracle installs to C:\Orant\Bin directory.

Import Specifies a path for the Oracle Import utility. By default, Oracle installs to C:\Orant\Bin directory.

SQL*Loader Specifies a path for the SQL * Loader utility. By default, Oracle installs to C:\Orant\Bin directory. 

Default Bind Size Specifies the bind size. Default is set to 70KB.

Option Description Default

Computer Name or IP Address Specify where the Performance Center Server is installed. localhost

Port Number Specify the port for the Apache server or IIS web server. 80

Test Verifies the settings.

Connect to the server using Specify if you want Rapid SQL to open the Web Client or 
the Performance Center file (PerfCntr.exe) within Rapid 
SQL.

Web 
Client

Interface 
Element

Option Description Default

Code Generation Generate Use Database 
statement

Adds a line of SQL code indicating which database or 
instance is used in the statement.

Selected

Generate owner names Adds a line of SQL code showing the table owner name as 
part of the query.

Selected

Include Row Count 
limits

Includes the output row limit set in the Execution settings. Not 
selected

Generate SQL/92 if 
supported by DBMS

SQL/92 is a standard for relational database management 
systems.

Not 
selected

Execution To set the maximum number of rows in your result set, type the number in the dialog box. 
This lessens congestion of server processes when queries execute by setting row count 
limits.

1000 
rows
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Reports options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Reports tab. The Reports tab lets you:

• Append a date and time time stamp to report file names. This prevents existing reports from being owverwritten.

• Save reports in date-specic folders.

• Save reports in PDF format as opposed to HTML.

• Let you include a provided image and title to reports.

General Show Column Data 
types in Query Diagram

Reveals the data type in each column for  tables in the SQL 
Diagram pane.

Not 
selected

Confirm on Item delete Opens a Confirm Delete dialog box when an item is deleted. Selected

Auto Populate Views Checks syntax every time an execute statement, refresh or 
copy statement begins.

Not 
Selected

Auto Format Automatically sets style and spacing of display. Selected

Auto Join Run Automatically Automatically detects names and data types, and create 
joins for multiple tables.

Selected

Require Indexes Joins only indexed columns. Requires an indexed column 
for joins.

Selected

Require same data type Automatically joins columns with the same data type. Selected

Syntax Checker Automatic Syntax Check Automatically checks SELECT and CREATE VIEW 
statements for errors.

Selected

Warn on non index join Returns a warning when it detects a join against a 
non-indexed column, or a column not participating in a 
primary key

Not 
selected

Display Lets you sets the style, size, and color of Column Font and Title Font. Also lets you set 
the background Table Color for the SQL Diagram Pane.

Available

Interface 
Element

Option Description Default
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Results (ISQL) options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Results tab. The table below describes the options and functionality on the Results Tab:    

Interface Element Options and descriptions

Results Option 
pane

Result Window Single Window - Displays all results in one tabbed result window. Multiple 
result sets together in the window. Single Window and Multiple Windows 
options are mutually exclusive.

Multiple Windows - Displays multiple result sets one result set per window. 

Attached to Editor - Sets results as tabbed windows attached to the ISQL 
window. Used in conjunction with Single Window option or Multiple Window 
option. Attached and Unattached options are mutually exclusive.

Unattached - Sets results appear separate from the ISQL Window. Used in 
conjunction with Single Window option or Multiple Windows option.

Reuse Window - Sets new result sets to overwrite any current result sets in an 
open Result Window. Only valid for Single and Attached to Editor combination.

Results File Mail File Type - Selects the file type to use when sending result sets via a 
MAPI-compliant mail package. Valid formats include the proprietary Results 
type, Tab delimited, Comma separated, and HTML.

Schedule File Type - Selects the schedule file type. Valid formats include Tab 
delimited, Comma separated, and HTML.

Include column titles when saving - Includes column titles when saving a 
result set. If this option is turned off, column titles Rapid SQL does not save 
result sets.

Result Set 
Options

Default Rowcount - Lets you limit the number of rows returned to the result 
window of the ISQL window (default 0).

Sybase and SQL Server: Text Size (bytes) - Lets you specify the text size 
(default 8192).

Oracle:LONG Size (bytes) - Lets you specify the LONG size (default 8192).

LOB Preview: Text Size (bytes) - Specifies the length of the preview of LOB 
column data (default 4096).

Sort Type Lets you select a result sorting: Alphanueric or Lexicographic.

Format pane Column 
Formatting

Auto Format (Best Fit) - Sets column widths automatically to accommodate 
the longest piece of data in a column. Large queries depend on the longest row 
formatting, so activating this option can affect performance.

Use pre-defined column - Lets you select column type and character length

Enable 
Date/Time 
Format

Lets you select the date/time format.
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SMTP mail options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the SMTP Mail tab. The SMTP Mail Tab of the Options Editor lets you specify outgoing notification e-mail message 
options. 

The table below describes the options and functionality on the SMTP Mail tab:

Format Standard Grid - Displays all result sets in a standard grid format. Rapid SQL 
displays result sets in grid format in IISQL Editors that are opened after you 
have selected this option. Rapid SQL does not display IISQL Editors that are 
already open.

HTML - Displays all result sets as HTML tables. Rapid SQL displays result sets 
in HTML format in ISQL Editors that are opened after you have selected this 
option. Rapid SQL does not display ISQL Editors that are already open.

ASCII Text - Displays all result sets as ASCII Text. Rapid SQL displays result 
sets in ASCII Text format in ISQL Editors that are opened after you have 
selected this option. Rapid SQL does not display ISQL Editors that are already 
open.

Grid Font and Printer Font buttons - Opens a Font dialog box, letting you 
select the font, style, and size for the result sets grid or printed result sets.

Option Description Default

Send messages through 
SMTP

Enables SMTP messaging and makes the other controls on 
this tab available.

Unselected

Name Name that appear as the e-mail sender. Name you specified during 
installation.

E-mail Address Address to send e-mails from Rapid SQL. E-mail address you 
specified during 
installation.

Authentication Lets you specify authentication options. None

User Name User name for authentication. Not available

Password Password for authentication. Not available

Host Name SMTP server for outgoing messages. For Microsoft Outlook, 
select Tools, and then Accounts. On the Mail Tab, select 
target account, and then click Properties. On Servers Tab, 
copy the Outgoing Mail(SMPT) and paste.

Host Name you specified 
during installation.

Port Number Port number you connect to on your outgoing SMTP server. 25

Test Opens an SMTP Configuration Test e-mail addressed to 
your e-mail address. Click Send Mail to send the e-mail.

Available

Bind to Your IP address the message is bound to. ANY_IP_ADDRESS

Encoding E-mail encoding. Western Europe (ISO)

Send messages Mime 
encoded

Messages encoded using Multipurpose Internet Mail 
Extensions (MIME) support enriched content and 
attachments.

Selected

Send all messages as HTML Messages include text formatting. Selected

Auto Connect to the Internet Rapid SQL connects to internet at launch. Selected

Interface Element Options and descriptions
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Version Control options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Version Control tab. The Version Control Tab of the Options Editor lets you select which version control 
system you want Rapid SQL to use as the underlying version control system.The table below describes Version 
Control options: 

Warnings options
After opening the Options editor (see Specifying Rapid SQL application and feature options), you can make changes 
to the Warnings tab. Rapid SQL lets you issue warning messages to users whenever improper operations are 
attempted in a database. Warning messages differ by platform.

The tables below describes the options of the Warnings Tab:

Item Description Default

Specify Version 
Control System

Lists the Version Control systems that integrate with Rapid SQL. Select the 
option button for the product you want Rapid SQL to use.

None

Optional Fields If you select Microsoft Visual SourceSafe, Rapid SQL uses your default 
SourceSafe database unless you override this setting by entering the path 
for the SourceSafe file associated with the desired database. To use a 
SourceSafe database other than the default, provide a user name, 
password, and the location of a scrsafe.ini file.

Optional

Option Description Platform

Create an index on the same 
tablespace as the 
associated table

Issues a warning message whenever a user does not create an index 
on a different tablespace than the table. This makes it possible for the 
server to read the index and table data in parallel.

DB2

Create an index on the same 
tablespace as the 
associated table

Issues a warning message whenever a user does not create an index 
on a different tablespace than the table. This makes it possible for the 
server to read the index and table data in parallel.

Oracle

Create an object in the 
SYSTEM tablespace

Issues a warning message whenever a user tries to create or place an 
object on the SYSTEM tablespace.

Oracle

Create a user with default or 
temp tablespace as the 
SYSTEM tablespace

Issues a warning message when a user is created with a default or temp 
tablespace on the SYSTEM tablespace.

Oracle

Create an object in the 
master database

Issues a warning message when an object is created in the master 
database.

Microsoft SQL 
Server and 
Sybase ASE

Create a table or index on 
the default segment

Issues a warning message when a table or index is created on the 
default segment.

Microsoft SQL 
Server and 
Sybase ASE

Create a non-clustered 
index on same segment as 
the associated table

Issues a warning message when a non-clustered index is created on 
the same segment as the associated table.

Microsoft SQL 
Server and 
Sybase ASE
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Using
Using shows how to use each component of the application. Using breaks each process and procedure into simple 
step-by-step instructions.

Using is divided into sections. The table below describes each section:

Section Description

Datasource Management This section describes the purpose of datasources, the 
process of establishing datasource connections, and 
managing your datasources and datasource groups. 

Supported Objects This section describes the different platform objects the 
application supports.

Modifying objects using editors This section describes Object editors. Editors let you modify 
existing objects.

Creating objects This section describes Object wizards. Editors let you create 
new objects.

Functionality This section describes the different platform object 
functionalities.

SQL Scripting This section describes the SQL scripting environment, that lets 
you write, debug, test and deploy solid SQL code for your 
database applications.

Permissions Management This section describes the Permissions Management features.

Project Management Describes Rapid SQL’s project-based features.

Version Control Describes how Rapid SQL integrates with version control 
software.



Datasource Management
After installing Rapid SQL, you must set up datasources to establish reusable connections to your database servers. A 
datasource is a database connection profile that is similar to the connection information that you have stored in your 
SQL.INI or WIN.INI files. Rapid SQL stores information about the datasource specification in the system registry and 
provides a visual interface for maintaining it.

The Datasource Registration Wizard guides you through the required steps to establish a connection to your server 
and makes the process of setting up datasources, easier. For details, see Registering or editing datasources.

This section describes the function of datasources, the process of establishing datasource connections and managing 
your datasources and datasource groups.

Datasources 
A datasource is a database connection profile. A datasource includes:

• Name

• Connection String

• Default User ID

• Optional Password Specification

All database operations are performed through datasources. You can create a datasource profile for each database 
instance (or database server) in your enterprise, and you can create multiple datasource profiles with different logins 
for a single database. The table below describes the data items stored for each datasource:

Available Functionality
Rapid SQL offers the following functionality for the Datasource Explorer:

• Change Group

• Connect

• Disconnect

• Drop

• Registering or editing datasources on page 94

• New LUW Datasource

Data Item Description

Name A unique, user-defined name for the datasource.

Connection 
String

For Oracle: the SQL*Net connect string, for Sybase ASE: the database server 
name.

Default User Default user ID to use when logging in to the datasource. Can be null.

Default 
Password

Default password to use when logging in to the datasource. This is encrypted. 
Can be null.

Auto-Connect 
Flag

If Yes, then automatically login using default user and password. If No, open 
Login dialog box.

Default 
Database

SYBASE ASE ONLY: Database to automatically use after logging in.
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• Register Datasource

• Unregister Datasource

Related Topics 

• Selecting Datasources

• Viewing Datasource Properties

Understanding the Datasource Catalog
A Datasource Catalog is a collection of defined datasources. On startup, Rapid SQL loads a Datasource Catalog 
using one of three methods, specified using the Options editor:

• Windows Registry datasource catalog - The datasource catalog is stored and managed locally, in the 
Windows registry. This user can add and delete datasources and edit the registration details of existing 
resources. Any changes are retained across startups of Rapid SQL.

This method is compatible with other Embarcadero products using registry-based datasource definition storage. 
If more than one of those products is installed on the same machine, they can share the same Datasource 
Catalog.

• File based datasource catalog - The datasource catalog is stored locally and is file-based. Each datasource 
definition included in the catalog is stored in a single file (.dsd file suffix) in the 
%APPDATA%\Embarcadero\Data Sources\ folder, in a default installation. This user can add and delete 
datasources and edit the registration details of existing resources. Any changes are retained across startups of 
Rapid SQL. 

This method is compatible with other Embarcadero products using file-based datasource definition storage. If 
more than one of those products is installed on the same machine with Rapid SQL, all can share the same 
Datasource Catalog.

• Network shared datasource catalog - The datasource catalog is file-based, and obtained from a user-specified 
location such as a network share. At each startup, Rapid SQL imports definitions from the network shared file 
(.etsds file suffix).

Changes such as new datasources, deleted datasources or edited datasource registrations are lost as soon as 
this user shuts down Rapid SQL. This method allows centralized maintenance of the Datasource Catalog and 
sharing of a single catalog among multiple users across a network.

NOTE: The definition files used in both the File based datasource catalog and Network shared 
datasource catalog methods do not store user ID and password credentials. Credentials, links 
to definition files in the current user’s catalog, and folder structure are stored in the 
%APPDATA%\Embarcadero\Data Sources\metadata\dsuri.xml file.

For information on choosing a method and specifying the network location of a Shared Datasource Management 
definition file, see Datasource options.

Regardless of the catalog storage method, the Datasource Catalog can be built manually by explicitly registering 
datasources or using automated methods such as the Discover Datasources feature. For details, see Automatically 
Discovering Datasources and Registering or editing datasources. Keep in mind that changes made with Network 
shared datasource catalog in effect, are lost on shutdown of Rapid SQL.

In order to set up a Network shared datasource catalog scheme, you can build a catalog first using the File based 
datasource catalog or Windows Registry datasource catalog method. You can subsequently use the Manage 
Datasources facility to export your Network shared datasource catalog file to the location that others will use to 
load the file. For details, see Importing and exporting datasource definitions.
EMBARCADERO TECHNOLOGIES>RAPID SQL® XE PRO AND RAPID SQL® 7.7 USER GUIDE 87



 > 
More generally, the Manage Datasources facility’s import/export functions can be used to exchange datasource 
definitions between users employing the different storage methods. Even more simply, these functions save time in 
allowing datasource definitions to be defined once and then shared with multiple users.

 

Automatically Discovering Datasources    
The first time you run Rapid SQL a dialog box displays, giving you the option to Auto-Discover all configured 
datasources. If you click Yes, the Rapid SQL Auto-Discover feature searches the DBMS configuration files on your 
computer and automatically discovers all the datasources that you are licensed for. For example, if you have a 
cross-platform license, Discover Datasources finds all unregistered datasources. If you have an Oracle only license, 
Discover Datasources finds all unregistered Oracle datasources.

NOTE: Microsoft SQL Server datasources are registered through a Windows NT system call to your 
network. Provide login information (user name and password) the first time you connect to a 
datasource.

NOTE: IBM DB2 LUW for Linux, Unix, and Windows databases use ODBC/CLI or DB2 (attach) to 
connect. Therefore, you need the proper ODBC/CLI Connection established in order for the 
auto-discover feature to find your IBM DB2 LUW for Linux, Unix, and Windows databases, 
including registering the DB2 datasource to ODBC as a system datasource. Although your 
datasources are auto-discovered, provide login information (user name and password) the first 
time you connect to a datasource.

In addition to Auto-Discovering your database servers, the application creates Datasource Groups based on RDBMS 
type. Each registered datasource is placed in its respective Datasource Group. For example, all Microsoft SQL Server 
datasources are added to the Microsoft SQL Server Group. Each registered datasource is placed in its respective 
Datasource Group.

For more information on how to configure your datasources, see Working with Datasources.

Changing Datasource Groups     
Rapid SQL lets you change datasource groups by:

• Dragging the datasource between groups.

• Invoking the Change Group dialog box.

Dragging and Dropping Between Groups
1 On the Datasource Explorer, left-click the datasource group you want to move, drag it over the folder for the new 

group, and release the pointer.

Using the Change Group Dialog Box
Disconnect your datasource before changing groups.

1 On the Datasource Explorer, right-click the datasource you want to move, and then click Change Group.

Rapid SQL opens the Change Group dialog box.

2 In the Select Group tree, click new group.
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3 Click OK.

Rapid SQL changes groups.

For more information, see Datasource Groups.

Connect         
Rapid SQL lets you set datasources to automatically connect each time you open the application.The first time you 
start the application, Rapid SQL prompts you to register your datasources. During this process, you can select the 
Auto Connect check box, which automatically connects all registered datasource each subsequent time you open the 
application. 

If you did not check the Auto Connect box, or if you clicked No when prompted to connect to a database after 
registering, you must connect manually, each time you want to access that datasource, using the Datasource Login 
dialog box. If you later want to automatically connect your datasources, edit the datasource accordingly. See 
Registering or editing datasources on page 94.

The table below describes the options and functionality on the Datasource Login dialog box:

For more information, see Completing the Datasource Login Dialog Box.

Completing the Datasource Login Dialog Box
To complete the Datasource Login dialog box, do the following:

1 On the Datasource menu, click Connect.

OR

On the Datasource tool bar, click Connect.

OR

On the Datasource Explorer tool bar, click Connect.

OR

On the Datasource Explorer, right-click the datasource, and then click Connect.

OR

On the Datasource Explorer, double-click the datasource.

Rapid SQL opens the Datasource Login dialog box.

2 In Login ID type the Login ID.

3 In Password type the password.

4 Select Auto Connect to automatically connect to the datasource in the future.

Option Description

Login ID Lets you type the Login ID. 

Password Lets you type the password.

Auto Connect Select to automatically connect to the datasource in 
the future, select the check box.
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5 Click Connect.

Rapid SQL opens the Datasource Landing Page in the right pane of the application.

For more information, see Working with Datasources.

Disconnect      
When you disconnect from a server, the application immediately breaks the connection between any open ISQL 
Windows, the servers, and databases. Although your ISQL Windows are still visible, the connections are no longer 
valid. If you attempt to execute a script, Rapid SQL attempts to reconnect to a registered datasource, if available.

For more information, see Completing the Disconnect Dialog Box.

Completing the Disconnect Dialog Box
To complete the Datasource Login dialog box, do the following:

1 On the Datasource menu, click Disconnect.

OR

On the Datasource tool bar, click Disconnect.

OR

On the Datasource Explorer tool bar, click Disconnect.

In the right pane of the Datasource Explorer window, right-click the datasource, and then click Disconnect.

Rapid SQL opens a dialog box asking if you want to commit all pending transactions for that connection or to 
rollback all before disconnecting. You cannot disconnect if there is an uncommitted transaction.

2 Click Yes.

Rapid SQL confirms you want to disconnect and closes the dialog box. 

Discover Datasource
Rapid SQL discovers datasources residing on your system that are not currently registered datasources through a 
Windows NT system call to your network. The Discover Datasource dialog box includes a list, which includes the 
name of the server or instance and the type of DBMS of all unregistered datasources found on your network or local 
machine. Once discovered, you have the option to register datasources.

Completing the Discover Datasources Dialog Box
1 On the Datasource menu, click Discover Datasource.

Rapid SQL opens the Discover Datasources dialog box.

2 Select the check box next to the datasource you want to register.

3 Click Select All to select all the datasources on the list.

4 Click Register.

Rapid SQL registers the datasource or datasources selected.
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5 Click OK.

Rapid SQL closes the Rapid SQL message.

For more information, see:

Datasources

Working with Datasources

Managing datasources   
The Manage Datasources dialog box lets you manage datasources throughout your enterprise from a single vantage 
point. It provides concise, relevant information on your datasources in a simple grid format. It provides centralized 
access to common datasource operations such as adding, modifying, deleting, discovering, importing, and exporting 
datasources. 

To open the Manage Datasources dialog box:

1 On the Datasource menu, click Manage Datasources.

Rapid SQL opens the Manage Datasources dialog box.

The grid format lets you access and view datasource specifications. datasources are grouped according to the default, 
DBMS-based folder structure and then within any custom datasource groups you have set up. The table below 
describes information available for each datasource entry: 

Column Description

Datasource Name Uses an explorer-like interface to display all registered datasources and their groups. You can 
navigate this column in the same manner as the datasource explorer, by clicking on nodes to 
expand or collapse your view of the datasources.

Connect String Displays the full connection string for the datasource.
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In addition, you can take the following actions:

• Click the New Datasource button to register a datasource. For more information, see Registering or editing 
datasources.

• Select a datasource and click the Edit Datasource button to edit that datasource definition. For more information, 
see Registering or editing datasources.

• Select a datasource and click the Remove Datasource button to unregister that datasource definition. For more 
information, see Unregistering Datasource.

• Click the Discover button to locate all configured datasources on your network and automate the process of 
registering them. For more information, see Automatically Discovering Datasources.

• Import or export datasource definitions. For details, see Importing and exporting datasource definitions.

Importing and exporting datasource definitions
On startup, Rapid SQL loads a Datasource Catalog, a collection of datasource definitions that the user can work 
against. How the catalog is stored and whether changes to the catalog are temporary or permanent, depends on the 
datasource storage method used. For an introduction, see Understanding the Datasource Catalog.

Regardless of the storage method used, Rapid SQL lets you add datasources to the currently loaded catalog by 
importing datasource definitions from the following sources:

• Windows Registry - if you previously used the Windows Registry datasource catalog storage method but are 
now using one of the file-based methods

• File based datasource catalog storage method files (.dsd file suffix) 

• Network shared datasource catalog storage method files (.etsds file suffix) 

Similarly, you can export the currently loaded Datasource Catalog definitions to File based datasource catalog or 
Network shared datasource catalog storage method files.

The ability to export and import datasource definitions provides a number of practical advantages. For example:

• Simple sharing among users - if you have a large number of datasources to register, you can have one user walk 
through the process of registering each datasource and then export those definitions. Other users can then 
import the resulting datasource definition files.

• Sharing definitions among users employing different datasource storage methods - datasource definitions or 
entire catalogs created using the Windows Registry datasource catalog or File based datasource catalog 
methods can be exported for use by users employing any of the three methods.

To export one or more datasource definitions:

1 On the Datasource menu, click Manage Datasources.

Rapid SQL opens the Manage Datasources dialog box.

Default User Id Displays the Default User ID for the datasource.

Auto-Connect? Indicates whether the Auto Connect feature is turned on or off.

Host Computer Displays the name of the Host Computer if one has been configured.

Default Schema Displays view default schemas for your DB2 datasources.

Column Description
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2 Select a single datasource, multiple datasources, or a default or custom datasource group folder.

NOTE: Datasource group folder information is not exported. Datasources are exported as individual files 
with no higher level grouping.

3 Click Export. An Export Data Sources Folder dialog opens.

4 Take one of the following actions:

• To export datasource definitions to individual files that can be imported on a datasource-by-datasource basis, 
select Export Data Sources to Individual Data Source Files and use the associated control to locate and 
select a target folder.

• To export datasource definitions to a single file for use by installations employing the Shared Datasource 
Managed catalog storage method, select Export Data Sources To a Shared Data Source Management File 
and use the associated control to locate and select a target folder and provide a file name. For information on 
how to designate a user as a Shared Datasource Managed catalog storage method, see Datasource options.

5 Click OK.

NOTE: User ID and password credentials are not exported to the datasource definition file. 

After export, other users can then import the datasource definitions.

To add one or more datasource definitions to a catalog:

1 On the Datasource menu, click Manage Datasources.

Rapid SQL opens the Manage Datasources dialog box.

2 Select the datasource group folder where the files or files are to be imported.

3 Click Import. An Import Data Sources dialog opens.

4 Take one of the following actions:

• If you previous used the Windows Registry catalog storage method but are currently using the Locally 
Managed or Shared Datasource Managed method, select Import Previously Registered Embarcadero Data 
Sources From Registry to load any datasources registered when you were using the Windows Registry 
catalog method.

• To import datasource definitions from individual datasource definition files (.dsd file suffix), select Import 
Previously Registered Embarcadero Data Sources From File(s), click Add, and use the Select 
datasource definitions to import dialog to locate and select the files to be added.

• To import datasource definitions from a single Shared Datasource Managed storage method file (.etsds file 
suffix) file, select Import Data Sources From a Shared Datasource Management File and use the 
associated control to locate and select the target file.

5 Click OK.

After importing a datasource definition file, you can either edit the datasource registration to provide security 
parameters or provide credentials when connecting to the datasource.

Managing Datasource Properties     
The Datasource Properties dialog box displays the name, type, version, status and mode of the datasource. The 
Datasource Properties box also lets you view the middleware or connectivity software that is being used to establish a 
particular datasource connection. You can use this information to troubleshoot connectivity problems, determining vital 
information such as the server version, connectivity library used, and library version and date.
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Completing the Datasource Properties Dialog Box
1 On the Datasource Explorer, click a datasource with an established connection.

2 On the Datasource menu, click Properties.

Rapid SQL opens the Datasource Properties dialog box.

For more information, see:

Datasources

Working with Datasources

Registering or editing datasources 
Each database instance must be registered. Whether you are registering a new data source, registering a new data 
source based on an existing data source definition, or editing preexisting connection information, you use the 
Datasource Registration dialog box.

To register a new data source:
• On the Explorer, right-click Managed Datasources, and select Register Datasource from the context menu.

To register a new data source based on an existing definition:
• In the left pane of the explorer, select the existing data source and then from the Datasource menu, select 

Register Like.

To edit registration information:
• On the Explorer, right-click a data source, and select Edit Datasource Registration from context menu.

The table below describe the fields you will encounter when registering a data source or editing the connectivity 
information:

Panel/Tab Option Description

Database Type Select the radio box corresponding to the DBMS type for the data source. If there is currently a DBMS 
node selected in the Explorer, that database type is automatically selected.

Connection 
Information

For detailed descriptions of the options on this tab, see Data Source connection information on page 97.

Advanced (only 
available on 
clicking the 
Advanced 
button on the 
Connection 
Information tab)

JDBC Driver You should see the JDBC Driver that’s appropriate to the platform. If 
you select ..., the JDBC Driver Editor opens letting you browse to a 
new or possibly undetected JDBC driver. For details, see JDBC Driver 
Editor.

NOTE: If you select a driver other than the default, you’ll be queried 
about whether you want that driver to be used for data sources you 
register going forward. Data sources already registered will not be 
affected.

Connection URL The connection URL cannot be edited--it’s for reference only. 

URL Check Indicates whether the connection URL is valid or not.
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Security 
Parameters

User ID The User ID that Rapid SQL will use to connect to the data source.

Password The password associated with the User ID.

Connect As: (Oracle) When relevant, choose the appropriate user/administrator level.

Domain: For MS SQL only. Identify the domain if the user has restricted 
access.

Auto connect? Spares the user from reentering the password every time you connect.

Connect using Windows 
Authentication or Connect 
using OS Authentication 
(IBM DB2 for Windows, Unix, 
and Linux, MySQL, Oracle, 
SQL Server)

Login to the server is verified using Windows/OS authentication

Connect using Kerberos 
Authentication (Sybase)

If this option is selected, login to the server is verified using Kerberos 
authentication.

NOTE: This is only available of the Use alias information in the 
SQL.INI file/Sybase Server option on the Connection Information 
tab is selected. For details, see Data Source connection information.

Test Connection When you test the connection, you’re testing both the native and 
JDBC connectivity. If the connection fails, read the error message and 
backtrack as necessary. 

Datasource 
Properties

#Include Search Directories Enter one or more paths on this datasource, which will be searched 
for files in conjunction with use of the #include directive in the ISQL 
editor, Procedure Object Editor, or Package Body Object Editor. 
Separate multiple paths using semicolons. For example:

c:\myscripts;c:\Program Files\Scripts
For more information on use of the #incliude directiive, see 
Preprocessing #define and #include directives.

Note that if there are no entries specified here, the directory specified 
on the Directories tab of the Options editor will be searched. For 
more informtion, see Directories options.

Database device default path The database device default path is used when creating a new 
database device.

Panel/Tab Option Description
EMBARCADERO TECHNOLOGIES>RAPID SQL® XE PRO AND RAPID SQL® 7.7 USER GUIDE 95



 > 
After clicking Finish, you are prompted to connect to the newly registered data source.

NOTE: On initial connection to a Sybase Cluster edition data source, you are offered the choice to 
connect to the entire cluster. If you select NO, your connection scope is an instance. This choice 
sets the default connection scope for this data source. You can subsequently change the 
connection scope for the data source by editing the data source.

NOTE: After you successfully connect to a data source, you can see the name of the host and the 
connection string information displayed at the bottom of the Rapid SQL window. For Oracle and 
Sybase ASE, should a question arise, you can see if perhaps you set up the data source NOT to 
use the alias file. You can also use these cues to remind yourself that if you changed the alias file, 
that change will not be reflected here unless you very specifically made a change to the defaults 
in the Options Editor-JDBC tab.

Oracle View 
Config (Oracle 
only)

Lets you manually configure Rapid SQL access to Oracle Data Dictionary DBA or ALL/USER views to 
conform to the view privileges associated with a specific role.

NOTE: In order to enable manual configuration of Oracle Data Dictionary views for Oracle datasources 
and make this panel available, you must select Use Datasource Configuration for Views in the 
Options Editor (File > Options > General > Oracle). For more information, see General options.

Only DBA views with an ALL/USER equivalent are offered on this panel. You can use the following 
methods to select DBA or ALL/USER type views on a view-by-view basis:

Manual selection using the Use 
DBA View check boxes

Selecting the Use DBA View check box associated with an individual 
view makes the DBA group version of that view available to Rapid 
SQL. Deselecting the Use DBA View check box associated with an 
individual view makes the ALL/USER group version of that view 
available to Rapid SQL.

Reset to All Deselects all Use DBA View check boxes, making only ALL views 
accessible to Rapid SQL.

Reset to DBA Selects all Use DBA View check boxes, making DBA views 
accessible to Rapid SQL.

Resolve Automatically (only 
available when editing a 
connected datasource)

Queries the datasource and selects the Use DBA View check box for 
each DBA view to which the current user has access.

Changes take effect as soon as you click the Finish button.

Datasource 
Group

Select the datasource group 
folder

Select the folder that is to contain this datasource.

Select a category If you want to use category-based user interface item color-coding 
and labelling for this datasource, this dropdown lets you select an 
existing category to assign this datasource to that category. You can 
also select Customize to manage your categories. For details, see 
Customizing datasource categories.

For an introduction to datasource categorization and related tasks, 
see Categorizing datasources using color-coding and labelling.

Panel/Tab Option Description
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Data Source connection information
The following table lists the Connection Information tab options, DBMS-by-DBMS, available when registering or 
editing a data source.

DBMS Option Description

IBM DB2 Server The name of the server.

Schema ID This is an optional field. If you want to include the current schema as part 
of the data source connection properties, you can set the implicit schema 
for unqualified object references to a schema different from the user’s login 
id.

Function Path This is an optional field. If you choose, you can enter the appropriate 
function path name so the search scope of functions will not be limited to 
the IBM DB2 library.

Datasource Name: This field is automatically populated with the server name, but you can 
rename it to whatever you want.

Interbase/Firebird Host name The name of the machine where the database resides.

Port Optionally, provide a port number.

Database file path The full path to the database file, a .gdb file for Interbase or a .fdb file for 
Firebird.

Datasource Name Optionally, override any value in this field with a value to be displayed in 
the Rapid SQL Datasource Explorer tree.

ODBC Connect String A valid ODBC connect string.

Datasource Name The name that will be displayed in the Rapid SQL Datasource Explorer 
tree.

SQL Server Use Network 
Library 
Configuration

When you select this, you can connect to a Net-Library that is listening on 
the server that is configured to either the Named Pipes or TCP/IP 
protocols.

Alias This box is enabled only when you opt to use the Network Library 
Configuration

Protocol: TCP/IP or 
Named Pipes

You need to select one or the other to register a SQL Server database.

Host Enabled only when you have not selected an Alias from the Network 
Library. 

Port (optional)/Pipe 
Name

Depending on your section, you can optionally indicate the port for TCP/IP 
or the pipe name depending on your means of connection.

Default DB 
(optional)

Optionally give the default name for the database.

Datasource Name The field is automatically populated with the host name, but you can 
rename to whatever you want.

MySQL Server Enter the name of the host, for example doctest01.

Port (optional) The default port is 3306. You do not need to enter this information.

Default Database You must enter the name of the default database. 

Datasource Name This field is automatically populated with the server name, but you can 
rename it to whatever you want.
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For context information, see Registering or editing datasources.

JDBC Driver Editor
The following table lists the controls available on the JDBC Driver Editor dialog. You use this dialog when defining or 
editing a data source.

Oracle Use TNS Names 
Alias/Oracle Alias

If this option is checked, look for the Alias you want to register from the 
drop-down list. The remaining fields will automatically populate. If it is 
unchecked, you must manually enter the requisite information.

Host Manually enter the name of the host machine.

Port The default is 1521, but you can change it to wherever the Oracle listener 
is set up.

SID/Service Name / 
Type: 
SERVICE_NAME or 
SID

Enter the SID or Service Name to correspond with the option you select. 

Instance Name The specific name used to identify the Oracle instance (the SGA and the 
Oracle processes).

Datasource Name The field is automatically populated with the host name, but you can 
change it.

Sybase Use alias 
information in the 
SQL.INI file/Sybase 
Server

If this option is selected, choose a name from the drop-down list in the 
Sybase Server field. 

Use SSL encryption If this option is selected, the JDBC connection will be established using 
SSL encryption

Host If you selected the Alias option, this field automatically populates. 
Otherwise, you need to manually enter the name of the host.

Port There is no default for this optional field.

Default DB 
(optional)

Optionally give the default name for the database.

Datasource This field automatically populates with the server name. You can change it 
to whatever you want.

Connection scope 
(Cluster Edition only)

Lets you specify a connection to the entire cluster or to a single instance.

Required Information Description

Driver Type The database platform.

Driver List You see what platform-specific drivers are available to you and which driver 
(highlighted) is currently associated with the server you are connecting to.

Driver Name

Driver Class The name of the class the driver uses for creating connections to the server. 

Version The driver’s version. 

Driver supports the use of native 
aliases

Rapid SQL cannot detect whether the driver you are using can support native 
aliases. You need to know by checking the driver’s documentation.

DBMS Option Description
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Customizing datasource categories
Rapid SQL lets you customize your datasource category scheme. A datasource category has the following 
configurable components:

• Category name - The name displayed as a selection in the Select a category dropdown

• Short Name - The abbreviation shown in the Datasource toolbar dropdown when a categorized datasource is 
selected.

• Color - The color used to denote a categorized datasource in Datasource Explorer tree icons and window tabs.

NOTE: Display of specific user items used to denote categories is configurable. For more information, see 
Datasource options.

To customize your datasource categories:
1 On the Datasource menu select Register Datasource and then select the Datasource Group panel.

2 From the Select a category dropdown select Customize. The Manage Datasource Categories dialogs opens.

3 Take one of the following actions:

• Create a new category by clicking New and selecting or providing a name, short name and color combination.

• Edit an existing category by selecting the category, clicking Edit and modifying the name and color 
combination.

NOTE: The short name for a category cannot be edited.

• Delete an existing category by selecting the category, clicking Delete and verifying the deletion at the prompt.

Selecting Datasources        
The Rapid SQL Select Datasource dialog box lets you select a datasource and connect to it.

Completing the Select Datasource Dialog Box
1 On the Datasource menu, click Select to open the Select Datasource dialog box.

2 Click the Datasource list box, and then click the target datasource.

3 Click Connect to connect to the datasource.

4 Click the Database list, and then click the target database.

5 Click OK to close the Select Datasource dialog box.

For more information, see:

Datasources

Working with Datasources

Required jars Rapid SQL detects the required jars and lists the path to them in the little window. 
You can select or add new jar files as required by your driver.

Required Information Description
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Unregistering Datasource
Rapid SQL lets you unregister datasources when you no longer need them.

TIP: Removing a datasource from Rapid SQL does not delete the physical database. It simply removes 
the datasource definition, and connection information, from the Rapid SQL catalog.

1 On the Datasource menu, click Unregister.

OR

On the Registration tool bar, click Unregister.

OR

On the Datasource Explorer, right-click the datasource, and then click Unregister Datasource.

Rapid SQL opens a dialog box.

2 Click Yes.

Rapid SQL confirms you want to unregister the datasource.

NOTE: The datasource manager is shared across Embarcadero's database management products. 
When you remove a datasource in any of Embarcadero's database management tools the 
datasource is removed across all relevant products.

For more information, see:

Datasources

Working with Datasources

Datasource Groups     
Rapid SQL lets you define datasource groups to organize the datasources in your enterprise. Datasource Groups 
behave as folders in the Windows Explorer, allowing you to group related datasources together. If you manage or 
monitor many Microsoft SQL Servers, datasource groups are a great mechanism for alleviating desktop clutter.

Anywhere that datasources are presented in a hierarchical tree format, datasource group folders expand to display 
one or more contained datasources. Upon installation of the first Embarcadero database management product, an 
initial datasource group is called Managed Datasources. You can rename this group.

Available Functionality
Rapid SQL offers the following functionality for Datasource Groups:

• Removing a datasource group

• New Datasource Group

• Rename Datasource Group

Removing a datasource group
Rapid SQL lets you remove database groups that you no longer need to access, or that have become obsolete. Keep 
the following in mind when removing datasource groups:

• If a datasource group contains datasources or other datasource groups, those items are deleted when you delete 
the containining group.
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• The default datasource groups correspond to the DBMS platforms supported by Rapid SQL. If you delete a 
default group, it will be recreated if you subsequently register a datasource for the associated platform.

To remove a datasource group:
1 Right-click the datasource, and then click Remove. Rapid SQL prompts you to verify.

2 Click Yes.

For more information, see Datasource Groups

New Datasource Group
Rapid SQL lets you define datasource groups to organize the datasources in your enterprise. Datasource Groups 
behave as folders in the Windows Explorer, allowing you to group related datasources together. If you manage or 
monitor many Microsoft SQL Servers, datasource groups are a great mechanism for alleviating desktop clutter.

Anywhere that datasources are presented in a hierarchical tree format, datasource group folders expand to display 
one or more contained datasources. Upon installation of the first Embarcadero database management product, an 
initial datasource group is called Managed Datasources. You can rename this group.

Completing the New Datasource Group Dialog Box
1 On the Datasource Explorer, right-click the datasource group folder, and then click New.

Rapid SQL opens the New Datasource Group dialog box.

2 In the Datasource Group Name box, type the new name of the datasource group.

3 Click OK.

Rapid SQL closes the New Datasource Group dialog box.

Rename Datasource Group
Rapid SQL lets you:

• Rename a datasource group.

• Change the members of a datasource group.

• Change the group to which a datasource belongs.

Completing the Rename Datasource Group
1 On the Datasource Explorer, right-click the datasource group folder, and then click Rename.

Rapid SQL opens the Rename Datasource Group.

2 In the Datasource Group Name box, type the new name of the datasource group.

3 Click OK.

Rapid SQL closes the Rename Datasource Group dialog box.
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4 On the Datasource menu, click Shutdown.On the Datasource menu, click Configure.

OR

On the Utilities tool bar, click Configure to open the Server Configuration dialog box.

OR

On the Datasource Explorer tool bar, click Configure to open the Server Configuration dialog box.  

On the Datasource menu, click Session Recording.

OR

On the Main tool bar, click Session Recording.On the Datasources menu, click Session Recording.

OR

On the Main tool bar, click Session Recording. On the File menu, click Open.

OR

On the Main tool bar, click Open. On the Datasource menu, click Find Object.

OR

On the Main tool bar, click Find.

OR

On the Datasource Explorer, right-click a database, and then click Find Object.

Option Description

Normal Shuts down the server in an orderly fashion. disables 
logins, and waits for currently executing 
Transact-SQL statements and stored procedures to 
finish. 

Immediate Shuts down the server immediately.  does not 
perform checkpoints in every database. The server 
terminates all user processes and rolls back any 
active transactions.

Option Description

Edit Button Click to modify the target parameter. Opens the Edit 
Configuration dialog box.

New Value Lets you type the value for the parameter.

Option Description

New Value Lets you type the value for the parameter.

Option Description

Session Name Lets you type the name of the session.

Session File Lets you type the location and session file name or 
click the browse button.  uses *.ses file extension for 
session files.
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Changing an ODBC Datasource to a Native Datasource

CAUTION: The section below refers only to Microsoft SQL Server connectivity.

Microsoft SQL Server uses ODBC to connect to Microsoft SQL Servers. Rapid SQL requires native connectivity. To 
connect through Rapid SQL, register your Microsoft SQL Server(s) using native connectivity in the Microsoft SQL 
Server Client Utility.

To change your ODBC servers to native connectivity, do the following: 

1 Open the Microsoft SQL Server Client Network Utility dialog box, CLICONFG.exe.

2 On the General Tab, click Add.

Microsoft SQL Server opens the Add Network Library Configuration dialog box.

The table below describes the options and functionality on the Add Network Library Configuration dialog box:

3 Click OK.

Rapid SQL returns to the Client Network Utility dialog box.

4 In the Client Network Utility dialog box, click Apply.

Rapid SQL adds the server.

Option Description

Object to Find Lets you type the target string of text. You can also 
click the list to choose from a list of up to ten previous 
search strings.

Type of Object Lets you select the target database object type.

Object Owner Lets you select the target database object owner.

Search Direction Lets you select a search direction:

From Beginning

Down

Up

Case-Sensitive Search Select to perform the search with the same 
capitalization as the search string.

Find Entire String Only Select to perform the search using the entire search 
string, not partial strings.

Search My Objects Only Select to perform the search only on your database 
objects.

Option Description

Server alias In the box, type the unique name of the server.

Network libraries In the box, click the appropriate option button to 
specify the network library that connects to the 
server.

Computer name In the box, type the name of the target computer.

Port number In the box, type the port number of the target 
computer.
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5 Open Rapid SQL and the Datasource Registration Wizard.

For more information, see Datasources.

Categorizing datasources using color-coding and labelling
Rapid SQL provides a means to visually distinguish between datasources used for different purposes in your 
organization. You can assign a category, such as development or production, when creating or editing a datasource. 
This color-codes or labels particular user interface elements associated with that datasource. 

When you assign a category to a datasource, the Datasource Explorer icons for the datasource shows a distinctive 
color-coded category indicator. Optionally, you can customize your categorization scheme to include the following user 
interface elements:

• A short name label included in the Datasource toolbar combo/dropdown when a categorized datasource is 
selected

• Color-coded tabs on windows associated with actions against a categorized datasource, editor or ISQL windows 
for example

• Color-coding of the status bar at the bottom of the Rapid SQL window

The default categories [and short name labels] and the associated colors are as follows:

Default Category Short Name Label Color

Production PROD
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In addition to the defaults, you can create custom category/color code/label category combinations. 

To work with color-coded datasource resources, you must be familiar with the following tasks:

• Enabling the specific user interface items that can be color-coded or labelled. For details, see Datasource 
options.

• Customizing your category scheme. For details, see Customizing datasource categories.

• Assigning a category to a datasource when creating or editing it. For details, see Datasource registration.

Development DEV

QA QA

Test TEST

Default Category Short Name Label Color
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Supported Objects
Rapid SQL lets you manage database objects across different database platforms. The table below indicates the 
objects that Rapid SQL supports by platform: 

Objects DB2 LUW  DB2 z/OS InterBase
Firebird

Oracle SQL Server Sybase

Aliases X X X X

Blob Filters X

Check Constraints X X X X X X

Clusters X

Database Links X X

Databases X X

DBRM X

Defaults X X

Domains X

Encryption Keys X

Exceptions X

External Functions X

Extended Procedures X

Foreign Keys X X X X X X

Functions X X X X X

Generators X

Indexes X X X X X X

Java Classes X

Java Resources X

Java Sources X

Libraries X

Logins X

Materialized Query 
Tables

X

Materialized Views X

Materialized View 
Logs

X

Outlines X

Package Bodies X

Packages X X X

Plans X

Primary Keys X X X X X X

Procedures X X X X X X
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Aliases 
NOTE: This object is supported by IBM DB2 LUW for Linux, Unix, and Windows, IBM DB2 LUW for 

OS/390 and z/OS, Microsoft SQL Server, and Sybase ASE.

Aliases let you assume the permissions of another database user without creating a separate user identity. You can 
use an alias when a users requires only temporary access to a database. You can also use an alias to mask a user’s 
identity. 

Available Functionality
Rapid SQL offers the following functionality for this object:

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

Profiles X

Rollback Segments X

Rules X X

Segments X X

Sequences X

Shadows X

Snapshots X

Snapshot Logs X

Stogroups X

Structured Types X X

Summary Tables X

Synonyms X

System Indexes X X X X X

System Tables X X X X X

Tables X X X X X X

Triggers X X X X X X

Type Bodies X

Types X

Unique Keys X X X X X X

User Datatypes X X X X

Users X X X X X X

Views X X X X X X

Objects DB2 LUW  DB2 z/OS InterBase
Firebird

Oracle SQL Server Sybase
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• Report

• Transfer Ownership

Blob Filters
Rapid SQL provides support for blob filters, user-written programs that convert data stored in Blob columns from one 
subtype to another.

NOTE: This object is supported by InterBase/Firebird only.

Creating and editing
See Blob Filters Wizard (InterBase/Firebird) and Blob Filters Editor (InterBase/Firebird).

Other functionality/object actions supported

Check Constraints        
NOTE: This object is supported on DB2 LUW, DB2 z/OS, InterBase/Firebird, Oracle, SQL Server, and 

Sybase.

Check constraints are data values that are acceptable in a column. They are logical expressions that verify column 
values meet defined acceptance criteria.

Available Functionality
Rapid SQL offers the following functionality for this object:

NOTE: Functionalities differ by platform.

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Rename

• Report

• Status

• Transfer Ownership

Clusters      
NOTE: This object is supported by Oracle only.

Drop Extract Rename Report
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Clusters provide an optional method of storing table data. A cluster comprises of a group of tables that share the same 
data blocks, and which are grouped together because they share common columns and are often used together. The 
related columns of tables stored in a cluster are known as the cluster key. 

There are two types of clusters: 

• Index 

• Hash 

Index clusters store the cluster data together and index the cluster key, which should make them faster at retrieving a 
range of data rows. 

Hash clusters apply hashing functions to the cluster key to determine the physical location of a data row, which should 
make them faster at retrieving specific data rows. 

NOTE: To place a table on a cluster, 6 include the ON CLUSTER syntax within the CREATE TABLE 
statement. Placing a table on a cluster precludes you from placing it on a tablespace or defining 
the associated storage parameters.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Allocate Extent

• Analyze

• Deallocate Unused Space

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Report

• Truncate

Database Links
NOTE: This object is supported by Oracle and Sybase only.

Database links are named schema objects that describe a path from one database to another. Database links are 
implicitly used when a reference is made to a global object name in a distributed database. To use a database link, 
either it is public or you own it.

NOTE: Oracle syntax does not let you alter an existing database link. To change its definition, drop and 
re-create it.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Drop

• Extract

• New - see Creating objects
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• Open - see Modifying objects using editors

• Rename

• Report

Databases
NOTE: Databases are available for Microsoft SQL Server and Sybase ASE. For Oracle and IBM DB2 

LUW for Linux, Unix, and Windows, IBM DB2 LUW for OS/390 and z/OS databases are called 
Instances.

Databases are a collection of tables, or a collection of index spaces and tablespaces. The goals of a database system 
are straightforward but challenging. In general, a database aims to manage large amounts of data in a multi-user 
environment. It should achieve high performance while letting many users access the same information concurrently 
without compromising data integrity. A database also must protect against unauthorized access and provide reliable 
solutions for failure recovery.

For more information, see Available Functionality.

IBM DB2 LUW for Linux, Unix, and Windows Instances
Databases are a collection of tables, or a collection of index spaces and tablespaces. The goals of a database system 
are straightforward but challenging. In general, a database aims to manage large amounts of data in a multi-user 
environment. It should achieve high performance while letting many users access the same information concurrently 
without compromising data integrity. A database also must protect against unauthorized access and provide reliable 
solutions for failure recovery.

For more information, see Available Functionality.

Microsoft SQL Server Databases
Databases are a collection of tables, or a collection of index spaces and tablespaces. The goals of a database system 
are straightforward but challenging. In general, a database aims to manage large amounts of data in a multi-user 
environment. It should achieve high performance while letting many users access the same information concurrently 
without compromising data integrity. A database also must protect against unauthorized access and provide reliable 
solutions for failure recovery.

For more information, see Available Functionality.

IBM DB2 LUW for OS/390 and z/OS Instances
Databases are a collection of tables, or a collection of index spaces and tablespaces. The goals of a database system 
are straightforward but challenging. In general, a database aims to manage large amounts of data in a multi-user 
environment. It should achieve high performance while letting many users access the same information concurrently 
without compromising data integrity. A database also must protect against unauthorized access and provide reliable 
solutions for failure recovery.

For more information, see Available Functionality.
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Sybase ASE Databases
Databases are a collection of tables, or a collection of index spaces and tablespaces. The goals of a database system 
are straightforward but challenging. In general, a database aims to manage large amounts of data in a multi-user 
environment. It should achieve high performance while letting many users access the same information concurrently 
without compromising data integrity. A database also must protect against unauthorized access and provide reliable 
solutions for failure recovery.

Available Functionality for Databases
Rapid SQL offers the following functionality for databases:

NOTE: Functionalities differ by platform.

• Checkpoint

• Coalesce

• DBCC

• Detach/Attach

• Drop

• Extract

• Move Log

• New - see Creating objects

• Open - see Modifying objects using editors

• Rename

• Report

• Set Online/Offline

• Shrink

• Update Statistics

DBRM
NOTE: This object is supported by IBM DB2 LUW for OS/390 and z/OS only.

A Database Request Module (DBRM) is an application containing information on SQL statements extracted from the 
DB2 precompiler. A DBRM refers to a specific database and is stored outside of the DB2 directory.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Report
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Defaults
NOTE: This object is supported by Microsoft SQL Server and Sybase only.

Defaults promote data integrity by supplying a default value to a table column if the user does not explicitly provide 
one. They are reusable objects that you can bind to table columns or user datatypes.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Rename

• Report

Domains
Rapid SQL provides support for domains, letting you work with these global column/datatype-based objects.

NOTE: This object is supported by InterBase/Firebird only.

Creating and editing
See Domains Wizard (InterBase/Firebird) and Domains Editor (InterBase/Firebird).

Other functionality/object actions supported

Encryption Keys
Rapid SQL provides support for encryption keys, used in encrypting and decrypting tables and columns.

NOTE: This object is supported by InterBase/Firebird only.

Creating and editing
See Encryption Keys wizard (InterBase/Firebird) and Encryption Keys editor (InterBase/Firebird).

Drop Extract Rename Report
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Other functionality/object actions supported

Exceptions
Rapid SQL provides support for exceptions, letting you work with these named error messages.

NOTE: This object is supported by InterBase/Firebird only.

Creating and editing
See Exceptions Wizard (InterBase/Firebird) and Exceptions Editor (InterBase/Firebird).

Other functionality/object actions supported

Extended Procedures 
NOTE: This object is supported by Sybase ASE only.

Extended Procedures are dynamic link libraries that can be used to load and execute application routines written in 
other programming languages, such as C or Visual Basic. Extended Procedures function and appear in the same 
manner as normal stored procedures in that you can pass parameters to them and obtain results.

NOTE: Extended Procedures can only be accessed on the Master database.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Dependencies

• Drop

• Execute

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Rename

• Report

External Functions
Rapid SQL provides support for external functions, letting you work with declarations for existing functions.

NOTE: This object is supported by InterBase/Firebird only.

Drop Extract Rename Report

Drop Extract Rename Report
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Creating and editing
See External Functions Wizard (InterBase/Firebird) and External Functions editor (InterBase/Firebird).

Other functionality/object actions supported

Foreign Keys 
NOTE: This object is supported on DB2 LUW, DB2 z/OS, InterBase/Firebird, Oracle, SQL Server, and 

Sybase.

Foreign keys enforce referential integrity between tables by verifying the existence of foreign key values in the parent 
table before letting you insert or update foreign key values in the child table.

Available Functionality
Rapid SQL offers the following functionality for this object:

NOTE: Functionality differs by platform.

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Rename

• Report

• Status

• Transfer Ownership

Functions       
NOTE: This object is supported by all platforms.

Functions are subroutines that you define. Functions are useful for reusable application logic. You can use functions to 
determine the best methods for controlling access and manipulation of the underlying data contained in an object.

The table below describes the types of user-defined functions that Rapid SQL lets you create: 

Rename

Function Description

Column or External Table 
Function

You can write in a host programming language, such as C. This 
function can act on a table and returns a table value rather than a 
scalar value.
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Available Functionality
Rapid SQL offers the following functionality for this object:

NOTE: Functionalities differ by platform.

• Create Synonym

• Dependencies

• Drop

• Extract

• Generate Anonymous Block

• New - see Creating objects

• Open - see Modifying objects using editors

• Report

• Transfer Ownership

Generators
Rapid SQL provides support for generators, letting you work with these objects used to generate sequential numbers 
in a column.

NOTE: This object is supported by InterBase/Firebird only.

Creating and editing
See Generators Wizard (InterBase/Firebird) and Generators editor (InterBase/Firebird).

External Scalar Function You can write in a language other than SQL, such as C++ or Java 
and returns a scalar value to the program. This type of function is 
referenced by the CREATE FUNCTION statement and can be 
used to perform computations on data contained in the database 
but cannot directly reference the data.

OLEDB Function Accesses OLE DB data in user-defined OLE DB external tables.

Sourced Function Inherits the semantics of another function and can be an operator.

Template Function Partial functions that do not contain any executable code. Mainly 
used in a federated database to map the template function to a 
data source function -Oracle, SQL Server, Sybase, etc. A function 
mapping needs to be created in conjunction with the template 
function. 

Function Description
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Other functionality/object actions supported

Indexes 
NOTE: This object is supported on DB2 LUW, DB2 z/OS, InterBase/Firebird, Oracle, SQL Server, and 

Sybase.

Indexes are optional structures associated with tables. You can create indexes specifically to speed SQL statement 
execution on a table. When properly used, Indexes are the primary means of reducing disk I/O. Indexes are logically 
and physically independent of the data in the associated table. Unique Indexes guarantee that no two rows of a table 
have duplicate values in the columns that define the index.

For more information, see:

IBM DB2 LUW for Linux, Unix, and Windows Indexes

IBM DB2 LUW for OS/390 and z/OS Indexes

Microsoft SQL Server Indexes

Oracle Indexes

Sybase ASE

Available Functionality

IBM DB2 LUW for Linux, Unix, and Windows Indexes
IBM DB2 LUW for Linux, Unix, and Windows offers two types of indexes:

• Unique

• Non-Unique

Unique Indexes guarantee that no two rows of a table have duplicate values in the columns that define the index.

For more information, see Available Functionality.

Microsoft SQL Server Indexes
Microsoft SQL Server offers two types of indexes: clustered and non-clustered. Clustered indexes physically sort table 
data to match their logical order. Non-clustered indexes only order the table data logically. In a database, an index lets 
you speed queries by setting pointers that allow you to retrieve table data without scanning the entire table. An index 
can be unique or non-unique.

Microsoft SQL Server creates indexes as B-Trees, which are a series of pointers mapping index pages to their 
underlying data pages. As tables and, therefore, indexes grow, the number of levels in the B-Tree increases. The 
B-Tree of a clustered index is shorter than that of a non-clustered index because the leaf level of a clustered index is 
the data page.

Drop Extract Rename Report
EMBARCADERO TECHNOLOGIES>RAPID SQL® XE PRO AND RAPID SQL® 7.7 USER GUIDE 116



 > 
A sound indexing strategy is critical to overall system performance. One pitfall to avoid is placing many indexes on a 
table without regard for their cumulative cost. Remember that indexes improve read but slow write performance 
because Microsoft SQL Server must update more information in the system catalog. Consequently, extra indexes can 
actually slow overall performance if data modification occurs frequently on the table. To determine the efficacy of 
indexes, you should tune your queries using SHOWPLAN and IO STATISTICS and analyze the selectivity of indexes 
using DBCC SHOW_STATISTICS.

Rapid SQL separates system indexes from user-defined indexes in the Datasource Explorer to ensure that system 
indexes are not accidentally altered or dropped.

For more information, see Available Functionality.

Oracle Indexes
Oracle offers two types of indexes. The table below describes these indexes:

The indexing strategy, particularly with large, active tables, is critical to overall system performance. The optimal 
definition and number of indexes for a given table is determined by the mix of access paths to that table performing 
insert, update, delete and select operations. For example, adding or changing an index can speed up your selects but 
slow your inserts, updates and deletes. Careful tuning and testing helps you achieve the best overall performance.

TIP: Indexes generally improve read operations in a database, but you should not place too many 
indexes on some tables. Since Oracle must maintain each index along with its referenced table, 
placing too many indexes on a table that is the object of much insert, update, and delete activity, 
can actually degrade performance.

Even when an index exists on a table, the way a SQL statement is coded can actually disallow the use of the index. To 
prevent this from happening, follow these rules of thumb: 

• Try not to use SQL statements that include the NOT IN, NOT LIKE, <>, IS NULL operators because they typically 
suppress the use of indexes.

• When referencing concatenated indexes with queries, be sure the leading column in the index is used. If it isn't, 
the index won't be used at all.

• Avoid using functions in WHERE predicates.

If you must use functions, and you are using Oracle8i, investigate the use of function-based indexes.

For more information, see Available Functionality.

Index Partitions
Index partitions are similar to table partitions. There are three types of partitioned indexes that Oracle supports:

1 Local prefixed

2 Local nonprefixed

3 Global prefixed

NOTE: An index cannot be partitioned if it is a cluster index or if the index is defined on a clustered table.

Index Description

Table A table index is defined on an individual table. 

Cluster A cluster index is defined on a set of tables physically stored 
together in a cluster. In an Oracle database, both table and cluster 
indexes use a B-tree structure. 
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Local prefixed and nonprefixed indexes
A local partitioned index has keys that refer to rows in a single table partition. A local partitioned index is automatically 
partitioned to mirror the underlying table. The number of partitions or subpartitions and the partition bounds for the 
partitioned index correspond with the partitions on the table. Oracle maintains this correspondence. If the table 
partitions are altered, the index partitions are altered accordingly.

A local partitioned index is prefixed if it is partitioned on the same column as the underlying table. The local partitioned 
index is nonprefixed if it is partitioned on a different column.

Global prefixed indexes

A global partitioned index can refer to rows in more than one table partition or subpartition. Global partitioned indexes 
are more difficult to manage than local partitioned indexes because any change in the underlying table partition affects 
all partitions in a global index. As a result, there is increased partition maintenance.

NOTE: A global index can only be range partitioned but it can be defined on any kind of partitioned table.

IBM DB2 LUW for OS/390 and z/OS Indexes
IBM DB2 LUW for OS/390 and z/OS offers two types of indexes:

• Unique

• Non-Unique

Unique Indexes guarantee that no two rows of a table have duplicate values in the columns that define the index.

Non-Unique indexes let table rows have duplicate values in the columns that define the indexes.

For more information, see Available Functionality.

Sybase ASE Indexes
Sybase ASE offers two types of indexes: clustered and non-clustered. Clustered indexes physically sort table data to 
match their logical order. Non-clustered indexes only order the table data logically. In a database, an index lets you 
speed queries by setting pointers that let you retrieve table data without scanning the entire table. An index can be 
unique or non-unique.

Sybase ASE creates indexes as B-Trees, which are a series of pointers mapping index pages to their underlying data 
pages. As tables and, therefore, indexes grow, the number of levels in the B-Tree increases. The B-Tree of a clustered 
index is shorter than that of a non-clustered index because the leaf level of a clustered index is the data page.

A sound indexing strategy is critical to overall system performance. One pitfall to avoid is placing many indexes on a 
table without regard for their cumulative cost. Remember that indexes improve read but slow write performance 
because Sybase ASE must update more information in the system catalog. Consequently, extra indexes can actually 
slow overall performance if data modification occurs frequently on the table. To determine the efficacy of indexes, you 
should tune your queries using SHOWPLAN and IO STATISTICS and analyze the selectivity of indexes using DBCC 
SHOW_STATISTICS.

Available Functionality for Indexes
Rapid SQL offers the following functionality for indexes:

NOTE: Functionality differs by platform.

• Analyze
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• Allocate Extent

• Convert to Partitioned

• Deallocate Unused Space

• Disable Index

• Drop

• DBCC

• Estimate Size

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Place

• Rebuild Index

• Rename

• Reorganize

• Report

• Set Statistics

• Transfer Ownership

• Update Statistics

Instance
NOTE: This object is support for IBM DB2 and Oracle.

Rapid SQL places Instance as the first level of information under the Datasource node in the Database Explorer. 
Instance includes:

• DB Manager Configuration

• Datasources

Available Functionality
Rapid SQL offers the following functionality for this object:

• New LUW Database - for details, see Database Wizard (IBM DB2 LUW)

Java Classes 
NOTE: This object is supported by Oracle 8i or later only.
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The Java Classes contain compiled Java code. Java Classes are made up of a group of data items, with associated 
functions that perform operations. The data items are called fields or variables; the functions are referred to as 
methods.

TIP: Oracle is shipped with a JVM(Java Virtual Machine). The JVM provided by Oracle sits atop the 
Oracle RDBMS and interacts directly with the RDBMS instead of the operating system.

Available Functionality
• Drop

Java Resources
NOTE: This object is supported by Oracle only.

The Java Resources node of the Explorer tab offers support for browsing Java resources.

Available Functionality
• Drop

Java Sources
NOTE: This object is supported by Oracle 8i or later only.

Java Sources contain the uncompiled Java source code.

TIP: Oracle is shipped with a JVM(Java Virtual Machine). The JVM provided by Oracle sits atop the 
Oracle RDBMS and interacts directly with the RDBMS instead of the operating system.

Available Functionality
• Compile

• Create or Edit Java Source

• Load Java

• Drop

Job Queues
NOTE: This object is supported by Oracle only.

Job Queues are built-in mechanisms that let you schedule a variety of SQL-based or command-line driven tasks.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Run

• New - see Creating objects

• Open - see Modifying objects using editors
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• Disable/Enable Job Queues

Libraries 
NOTE: This object is supported by Oracle only.

Libraries are an object type introduced in Oracle8 that represent a call to an operating system shared library. After the 
call is made, libraries can be used by SQL or PL/SQL to link to external procedures or functions. Libraries are only to 
be used on operating systems that support shared libraries and dynamic linking. Libraries serve as pointers or aliases 
to physical operating system shared library files and do not have existence as a physical object on their own, rather 
they rely on the physical existence of the files in the external operating system library to which they refer. To access 
the function or procedures stored in the library, you need execute privileges at the operating system level where the 
shared library resides.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Rename

• Report

Logins
NOTE: This object is supported by Microsoft SQL Server and Sybase only.

Logins let you access your account. Your login account controls access to the server and all of the databases within it. 
Only the System Administrator or System Security Officer can create logins. Once you can log into a server, you need 
additional privileges to access user databases. Specifically, each database owner adds the login as a user or alias to 
the database.

NOTE: Logins are available for Microsoft SQL Server and Sybase ASE.

Microsoft SQL Server Logins
Logins let you access your account. Your login account controls access to the server and all of the databases within it. 
Only the System Administrator or System Security Officer can create logins. Once you can log into a server, you need 
additional privileges to access user databases. Specifically, each database owner adds the login as a user or alias to 
the database.

For more information, see Available Functionality.
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Sybase ASE Logins
Logins let you access your account. Your login account controls access to the server and all of the databases within it. 
Only the System Administrator or System Security Officer can create logins. Once you can log into a server, you need 
additional privileges to access user databases. Specifically, each database owner adds the login as a user or alias to 
the database.

For more information, see Available Functionality.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Change Password

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Report

Materialized Query Tables
NOTE: This object is supported by IBM DB2 LUW for Linux, Unix, and Windows version 8.

A materialized query table is a table whose definition is based on the result of a query. The materialized query table 
typically contains pre-computed results based on the data existing in the table or tables that its definition is based on. 
If the SQL compiler determines that a query will run more efficiently against a materialized query table than the base 
table or tables, the query quickly executes against the materialized query table.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Create Insert Statements

• Create Synonym

• Drop

• Edit Data

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Refresh Summary Table

• Rename

• Report

• Transfer Ownership
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Materialized Views
NOTE: This object is supported by Oracle only.

Materialized views are used to dynamically copy data between distributed databases. There are two types of 
materialized views:

• Complex

• Simple

Complex materialized views copy part of a master table or data from more than one master table. Simple materialized 
views directly copy a single table. You cannot directly update the underlying data contained in materialized views.

NOTE: Materialized Views are only in Oracle 8.1 or later. If you are using Oracle 8.0 or earlier, see 
Snapshots.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Create Synonym

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Rename

• Report

Materialized View Logs
NOTE: This object is supported by Oracle only.

Materialized View logs are tables that maintain a history of modifications to the master table, and they are used to 
refresh simple materialized views. When you create a materialized view log, Oracle automatically creates a log table 
to track data changes in the master table and a log trigger to maintain the data in the log table.

NOTE: Materialized View Logs are in Oracle 8i or later. If you are using Oracle 8.0 or earlier, see 
Snapshot Logs.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Report
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Oracle Job Queues
NOTE: This object is supported by Oracle only.

Oracle job queues are built-in mechanisms in the Oracle database that let you schedule a variety of SQL-based or 
command-line driven tasks. Basically, they are database-driven schedulers.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Report

Outlines
NOTE: This object is supported by Oracle 8.1 or later only.

Outlines are a set of results for the execution plan generation of a particular SQL statement. When you create an 
outline, plan stability examines the optimization results using the same data used to generate the execution plan. That 
is, Oracle uses the input to the execution plan to generate an outline, and not the execution plan itself.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Change Category

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Reassign by Category

• Rebuild Outlines

• Rename

• Report

Packages 
NOTE: This object is supported by IBM DB2 LUW for Linux, Unix, and Windows, IBM DB2 for OS/390 

and z/OS, and Oracle only.

Packages contain all the information needed to process SQL statements from a single source file. You can use 
packages to process and call batches of SQL. Depending on the platform, packages can include:
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• Procedures

• Functions

• Types

• Variables

• Constants

• Exceptions

• Cursors

• Subprograms

Packages offer a number of important advantages over using standalone procedures and functions, including the 
ability to:

• Modify package objects without recompiling dependent database objects.

• Declare global variables and cursors that can be shared within the package.

• Grant privileges more efficiently.

• Load multiple package objects into memory at once.

Packages usually have two parts: a header or specification and a body, although sometimes the body is unnecessary. 
The package header declares the members of the package while the body details the logic underlying each of the 
package components.

Available Functionality
Rapid SQL offers the following functionality for this object:

NOTE: Functionalities differ by platform.

• Bind Package

• Create Synonym

• Dependencies

• Drop

• Explain Plan

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Rebind Packages

• Report

Package Bodies 
NOTE: This object is supported by Oracle only.
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Package Bodies implement the package specification in that the package body includes the definition of every cursor 
and subprogram declared in the package specification. While Package Bodies are listed as a separate object in the 
Datasource Explorer, they are created on the Packages Editor in conjunction with Packages. For details, see 
Packages Editor (Oracle)

Available Functionality
Rapid SQL offers the following functionality for this object:

• Create Synonym

• Dependencies

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Report

Plans
NOTE: This object is supported by IBM DB2 LUW for OS/390 and z/OS only.

A Plan is an executable application created in the bind process. It can include one or more packages or debris.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Bind Plan

• Copy Object Names

• Drop

• Free Plans

• Open - see Modifying objects using editors

• Rebind Plans

• Report

Primary Keys 
NOTE: This object is supported on DB2 LUW, DB2 z/OS, InterBase/Firebird, Oracle, SQL Server, and 

Sybase.

Primary Keys are a set of table columns that can uniquely identify every row of a table. 

Available Functionality
Rapid SQL offers the following functionality for this object:

NOTE: Functionalities differ by platform.
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• Disable Index

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Rebuild Index

• Rename

• Reorganize

• Report

• Status

• Transfer Ownership

Procedures 
NOTE: This object is supported on DB2 LUW, DB2 z/OS, InterBase/Firebird, Oracle, SQL Server, and 

Sybase.

Procedures are a reusable block of PL/SQL, stored in the database, that applications can call. Procedures streamline 
code development, debugging and maintenance by being reusable. Procedures enhance database security by letting 
you write procedures granting users execution privileges to tables rather than letting them access tables directly.

NOTE: Only IBM DB2 LUW for OS/390 and z/OS SQL stored procedures created by Rapid SQL, 
DBArtisan, or IBM's Stored Procedure Builder can be retrieved by Rapid SQL or DBArtisan.

Sybase ASE
Procedures perform procedural logic in your Sybase ASE applications. They are batches of SQL statements that are 
compiled and stored in the system catalog. Procedures execute faster than embedded SQL statements because they 
are pre-compiled and have execution plans for use by the optimizer. When you create a procedure, Sybase ASE 
builds a query tree, which it stores in a system table. When you execute a procedure for the first time, Sybase ASE 
loads it from the system table, compiles, and optimizes it. Sybase ASE places the resulting query plan in the 
procedure cache where it remains on a most recently used basis. In addition to better performance, procedures yield 
other benefits, including easier code maintenance, additional security and reduced network traffic.

In addition, Rapid SQL now supports extended procedures. Extended procedures are dynamic link libraries that can 
be used to load and execute application routines written in other programming languages, such as C or Visual Basic. 
Extended procedures function and appear in the same manner as normal procedures in that you can pass parameters 
to them and obtain results.

Available Functionality
Rapid SQL offers the following functionality for this object:

NOTE: Functionalities differ by platform.

• Create Synonym

• Drop

• Dependencies
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• Execute

• Extract

• Generate Anonymous Block

• New - see Creating objects

• Open - see Modifying objects using editors

• Rename

• Report

• Transfer Ownership

Profiles    
NOTE: This object is supported by Oracle only.

Profiles are a mechanism for allocating system and database resources to users. Profiles let you specify limits on:

• Number of sessions

• CPU time

• Connect time

• Idle time

• Logical reads and space in the SGA's shared pool

You can assign profiles to one or more users. The database's default profile and all of its resource limits are assigned 
to users without a specific profile assignment.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Report
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Rollback Segments

NOTE: This object is supported by Oracle only.

Rollback segments manage all transactions in your Oracle databases. They maintain read consistency among 
concurrent users in a database and can rollback transactions. They are transaction logs that maintain discrete records 
of changes to data. By maintaining a history of data changes, rollback segments can rollback uncommitted 
transactions so that data is rolled back to their prior state. 

TIP: Databases with large user bases and intensive data manipulation characteristics can benefit from 
having multiple rollback tablespaces that are placed on different server drives or file systems. This 
strategy aids in the reduction of I/O and rollback segment contention.

Microsoft SQL Server 7

Column Name Description

Remote Server Name Name of the server

Net Name Reserved (name of the server)

Product Name Product name for the remote server(e.g. Microsoft SQL 
Server)

Ole Provider Name Name of the Ole provider accessing the server

Sybase ASE

Column Name Description

Remote Server Name Name of the server

Network Name Name of the network on which the Remote Server resides 

Timeouts Shows whether or not the Timeout option has been enabled. If it is 
set to 1 then the site handler for the remote login will timeout if there 
is no remote user activity for one minute. 

Column Name Description

Role Name Name of the role

Role Type Whether the role is a standard Microsoft SQL Server role or 
an application role

Created When the role was created

Updated When the role was last updated

Column Name Description

Role Name Name of the role

Password Required Password authentication for the role. The valid values are 
Yes (specific password required), No (no password 
required), External (password is authenticated through the 
operating system) or Global (password is authenticated 
through the security domain central authority).

Column Name Description

Role Name Name of the role
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Because all changes are logged to a rollback segment, they can become a performance bottleneck as the number of 
concurrent users and transaction activity increases. You can tune rollback segment performance by creating additional 
ones to handle increased traffic. To determine whether rollback segment performance is satisfactory, you should 
monitor the ratio of gets to waits. If you see that the number of waits is climbing, create another rollback segment to 
further spread concurrency. 

NOTE: The analysis for determining when to add a rollback segment can be quite complicated. As a 
rule-of-thumb, however, many DBAs simply plan on allocating a rollback segment for every four 
concurrent users. 

The proper sizing of rollback segments is critical to their overall performance. Performance degrades whenever a 
rollback segment must extend, wrap or shrink in response to transaction loads. Ideally, you want to make their extents 
as small as possible while ensuring that each transaction fits into a single extent, which in practice is very difficult to 
achieve. 

NOTE: You should carefully monitor each rollback segments for the occurrence of extends, wraps and 
shrinks. If you see a high level of extends and wraps, then the rollback segment is probably too 
small. If you see a high level of shrinks, then you should increase the rollback segment's optimal 
size.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Report

• Shrink

Rules
NOTE: This object is supported by Microsoft SQL Server and Sybase only. 

Rules promote data integrity by allowing you to validate the values supplied to a table column. They are reusable 
objects that you can bind to table columns or user datatypes. For example, you can create a rule, bind it to a column in 
a table and have it specify acceptable values that can be inserted into that column. 

Available Functionality
Rapid SQL offers the following functionality for this object:

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Rename

• Report
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Segments
NOTE: This object is supported by Sybase only. 

Segments are a mechanism for placing tables and indexes on specific logical partitions. You create segments on one 
or more fragments of a database. You can map segments to specific database fragments, which in turn reside on 
specific hard disks; and, mapping segments lets you increase i/o throughput by placing intensively used tables and 
indexes on different physical devices. You can allocate tables and indexes to segments by including placement 
statements at the end of CREATE TABLE or CREATE INDEX statements. 

Available Functionality
Rapid SQL offers the following functionality for this object:

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Report

Sequences 
Sequences are programmable database objects that generate a definable sequence of values. Once defined, a 
sequence can be made available to many users. A sequence can be accessed and incremented by multiple users 
with no waiting. A sequence can be used to automatically generate primary key values for tables. When you create a 
sequence, you can define its initial value, increment interval and maximum value.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Create Alias

• Create Synonym

• Dependencies

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Rename

• Report

• Restart

• Transfer Ownership
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Shadows
Rapid SQL provides support for shadows, letting you create one or more in-sync copies of the database stored on 
secondary storage devices.

NOTE: This object is supported by InterBase/Firebird only.

Creating and editing
See Shadows wizard (InterBase/Firebird) and Shadows editor (InterBase/Firebird).

Other functionality/object actions supported

Snapshots 
NOTE: This object is supported by Oracle only.

Snapshots are used to dynamically copy data between distributed databases. There are two types of snapshots:

• Complex

• Simple

NOTE: Snapshots are available in Oracle 8.0 and earlier. For Oracle 8i or later, see Materialized Views.

Complex snapshots copy part of a master table or data from more than one master table. Simple snapshots directly 
copy a single table. You cannot directly update the underlying data contained in snapshots. 

NOTE: To use snapshots, use the Oracle 7 Distributed Option.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Create Synonym

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Rename

• Report

Snapshot Logs 
NOTE: This object is supported by Oracle only.

Drop Extract Rename Report
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Snapshot logs are tables that maintain a history of modifications to the master and they are used to refresh simple 
snapshots. When you create a snapshot log, Oracle automatically creates a log table to track data changes in the 
master table and a log trigger to maintain the data in the log table. 

NOTE: Snapshot Logs are available in Oracle 8.0 or earlier. For Oracle 8i or later, see Materialized View 
Logs.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Report

Stogroups 
NOTE: This object is supported by IBM DB2 LUW for OS/390 and z/OS only.

Stogroups are storage groups, named sets of  volumes on which DB2 LUW for OS/390 data is stored.

Available Functionality
Rapid SQL offers the following functionality for this object:

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Report

Structured Types 
NOTE: This object is supported by IBM DB2 LUW for Linux, Unix, and Windows and IBM DB2 LUW for 

OS/390 and z/OS only.

Structured types define an abstract data type or object composed of a collection of similar types of data. For example, 
create an structured type that defines a full address rather than the pieces of an address, such as city, state and postal 
code. An structured type stores the pieces of an address in a single type, storing them in the same location and 
allowing the full address to be accessed and manipulated as single unit rather than multiple units. 

Structured types are useful for ensuring uniformity and consistency as they are defined as single encapsulated entity 
that can be reused in other structured types and objects. They also offer flexibility by allowing for the creation of 
objects that represent real-world situations which is limited in relational objects. 

Available Functionality
Rapid SQL offers the following functionality for this object:
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• Dependencies

• Drop

• Extract

• New - see Creating objects

• Report

• Transfer Ownership

Summary Tables
NOTE: This object is supported by IBM DB2 LUW for Linux, Unix, and Windows version 7.

A summary table is a table whose definition is based on the result of a query. The summary table typically contains 
pre-computed results based on the data existing in the table or tables that its definition is based on. If the SQL 
compiler determines that a query will run more efficiently against a summary table than the base table or tables, the 
query quickly executes against the materialized query table. 

Available Functionality
Rapid SQL offers the following functionality for this object:

• Create Synonym

• Drop

• Extract

• New - see Creating objects

• Open - see Modifying objects using editors

• Rename

• Report

Synonyms 
NOTE: This object is supported by IBM DB2 LUW for OS/390 and z/OS and Oracle only.

Synonyms are an alternate name for an object in the database. Depending on the platform, you can define synonyms 
on tables, views, sequences, procedures, functions, packages and materialized views. There are two types of 
synonyms:

• Public

• Private

Public synonyms can be used by everyone in the database. Private synonyms belong to the synonym owner.

Synonyms simplify object names and let you:

• Reference an object without needing to specify its owner.

• Reference a remote object without needing to specify its database.

• Alias an object so its purpose becomes more understandable.
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